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Notes regarding these materials

This document is provided for reference purposes only so that Renesas customers may select the appropriate
Renesas products for their use. Renesas neither makes warranties or representations with respect to the
accuracy or completeness of the information contained in this document nor grants any license to any
intellectual property rights or any other rights of Renesas or any third party with respect to the information in
this document.
Renesas shall have no liability for damages or infringement of any intellectual property or other rights arising
out of the use of any information in this document, including, but not limited to, product data, diagrams, charts,
programs, algorithms, and application circuit examples.
You should not use the products or the technology described in this document for the purpose of military
applications such as the development of weapons of mass destruction or for the purpose of any other military
use. When exporting the products or technology described herein, you should follow the applicable export
control laws and regulations, and procedures required by such laws and regulations.
All information included in this document such as product data, diagrams, charts, programs, algorithms, and
application circuit examples, is current as of the date this document is issued. Such information, however, is
subject to change without any prior notice. Before purchasing or using any Renesas products listed in this
document, please confirm the latest product information with a Renesas sales office. Also, please pay regular
and careful attention to additional and different information to be disclosed by Renesas such as that disclosed
through our website. (http://www.renesas.com )
Renesas has used reasonable care in compiling the information included in this document, but Renesas
assumes no liability whatsoever for any damages incurred as a result of errors or omissions in the information
included in this document.
When using or otherwise relying on the information in this document, you should evaluate the information in
light of the total system before deciding about the applicability of such information to the intended application.
Renesas makes no representations, warranties or guaranties regarding the suitability of its products for any
particular application and specifically disclaims any liability arising out of the application and use of the
information in this document or Renesas products.
With the exception of products specified by Renesas as suitable for automobile applications, Renesas
products are not designed, manufactured or tested for applications or otherwise in systems the failure or
malfunction of which may cause a direct threat to human life or create a risk of human injury or which require
especially high quality and reliability such as safety systems, or equipment or systems for transportation and
traffic, healthcare, combustion control, aerospace and aeronautics, nuclear power, or undersea communication
transmission. If you are considering the use of our products for such purposes, please contact a Renesas
sales office beforehand. Renesas shall have no liability for damages arising out of the uses set forth above.
Notwithstanding the preceding paragraph, you should not use Renesas products for the purposes listed below:

(1) artificial life support devices or systems

(2) surgical implantations

(3) healthcare intervention (e.g., excision, administration of medication, etc.)

(4) any other purposes that pose a direct threat to human life
Renesas shall have no liability for damages arising out of the uses set forth in the above and purchasers who
elect to use Renesas products in any of the foregoing applications shall indemnify and hold harmless Renesas
Technology Corp., its affiliated companies and their officers, directors, and employees against any and all
damages arising out of such applications.
You should use the products described herein within the range specified by Renesas, especially with respect
to the maximum rating, operating supply voltage range, movement power voltage range, heat radiation
characteristics, installation and other product characteristics. Renesas shall have no liability for malfunctions or
damages arising out of the use of Renesas products beyond such specified ranges.

. Although Renesas endeavors to improve the quality and reliability of its products, IC products have specific

characteristics such as the occurrence of failure at a certain rate and malfunctions under certain use
conditions. Please be sure to implement safety measures to guard against the possibility of physical injury, and
injury or damage caused by fire in the event of the failure of a Renesas product, such as safety design for
hardware and software including but not limited to redundancy, fire control and malfunction prevention,
appropriate treatment for aging degradation or any other applicable measures. Among others, since the
evaluation of microcomputer software alone is very difficult, please evaluate the safety of the final products or
system manufactured by you.

. In case Renesas products listed in this document are detached from the products to which the Renesas

products are attached or affixed, the risk of accident such as swallowing by infants and small children is very
high. You should implement safety measures so that Renesas products may not be easily detached from your
products. Renesas shall have no liability for damages arising out of such detachment.

. This document may not be reproduced or duplicated, in any form, in whole or in part, without prior written

approval from Renesas.

. Please contact a Renesas sales office if you have any questions regarding the information contained in this

document, Renesas semiconductor products, or if you have any other inquiries.







Introduction

This manual describes the followings

- E8a Emulator functions
- Preparation before use
- Debugger functions
- Tutorial
- Appendix: (Components of the E8a Emulator, Notes on High-performance Embedded
Workshop, and Diagnostic Test Procedure)

This manual does not intend to explain how to write C/C++ or assembly language programs, how
to use any particular operating system or how best to tailor code for the individual devices. These
issues are left to the respective manuals.

Microsoft® and Windows® are registered trademarks of Microsoft Corporation.
IBM is a registered trademark of International Business Machines Corporation.

All brand or product names used in this manual are trademarks or registered trademarks of their
respective companies or organizations.



Document Conventions

This manual uses the following typographic conventions:

Table 1 Typographic Conventions

Convention Meaning
[Menu->Menu Option] Bold text with ‘->’ is used to indicate menu options
(for example, [File->Save As...]).
FILENAME.C Uppercase names are used to indicate filenames.
“enter this string” Used to indicate text that must be entered (excluding the “’ quotes).
Key + Key Used to indicate required key presses. For example, CTRL+N means

press the CTRL key and then, whilst holding the CTRL key down,
press the N key.

) When this symbol is used, it is always located in the left hand margin.
It indicates that the text to its immediate right is describing “how to”

(The “how to” symbol) )
do something.




IMPORTANT
READ FIRST

Before using this product, be sure to read the user’s manual (this user's manual) carefully.
Keep this user’s manual, and refer to this when you have questions about this product.

Emulator:

The emulator in this document refers to the following products that are manufactured by Renesas
Technology Corp.:

(1) Emulator

(2) User system interface cable

The emulator herein does not include the customer’s user system and host machine.

Purpose of use of the emulator:

This emulator is a device to support the development of a system that uses the Renesas MCUs. It
provides support for system development in both software and hardware.

Be sure to use this emulator correctly according to said purpose of use. Please avoid using this
emulator for other than its intended purpose of use.

For those who use this emulator:

This emulator can only be used by those who have carefully read the user’s manual and know how
to use it.

Use of this emulator requires the basic knowledge of electric circuits, logical circuits, and MCUs.

When using the emulator:

(1) This product is a development supporting unit for use in your program development and
evaluation stages. In mass-producing your program you have finished developing, be sure to
make a judgment on your own risk that it can be put to practical use by performing
integration test, evaluation, or some experiment else.

(2) In no event shall Renesas Solutions Corp. be liable for any consequence arising from the use
of this product.

(3) Renesas Solutions Corp. strives to renovate or provide a workaround for product malfunction
at some charge or without charge. However, this does not necessarily mean that Renesas
Solutions Corp. guarantees the renovation or the provision under any circumstances.

(4) This product has been developed by assuming its use for program development and
evaluation in laboratories. Therefore, it does not fall under the application of Electrical
Appliance and Material Safety Law and protection against electromagnetic interference when
used in Japan.

(5) Renesas Solutions Corp. cannot predict all possible situations or possible cases of misuse
where a potential danger exists. Therefore, the warnings written in this user’s manual and the
warning labels attached to this emulator do not necessarily cover all of such possible
situations or cases. Please be sure to use this emulator correctly and safely on your own
responsibility.

(6) This product is not qualified under UL or other safety standards and IEC or other industry
standards. This fact must be taken into account when taking this product from Japan to some
other country.



Usage restrictions:

This emulator has been developed as a means of supporting system development by users.
Therefore, do not use it as a device used for equipment-embedded applications. Also, do not use it
for developing the systems or equipment used for the following purposes either:

(1) Transportation and vehicular

(2) Medical (equipment where human life is concerned)

(3) Aerospace

(4) Nuclear power control

(5) Undersea repeater

If you are considering the use of this emulator for one of the above purposes, please be sure to
consult your local distributor.

About product changes:

We are constantly making efforts to improve the design and performance of this emulator.
Therefore, the specification or design of this emulator or its user’s manual may be changed
without prior notice.

About the rights:

We assume no responsibility for any damage or infringement on patent rights or any other rights

arising from the use of any information, products or circuits presented in this user’s manual.

(1) We assume no responsibility for any damage or infringement on patent rights or any other
rights arising from the use of any information, products or circuits presented in this user’s
manual.

(2) The information or data in this user’s manual does not implicitly or otherwise grant a license
for patent rights or any other rights belonging to us or third parties.

(3) This user’s manual and this emulator are copyrighted, with all rights reserved by us. This
user’s manual may not be copied, duplicated or reproduced, in whole or part, without prior
written consent of us.

About diagrams:
The diagrams in this user’s manual may not all represent exactly the actual object.

Device names:
Sections 1 through 6 in this user’s manual use R8C/Tiny as an example of the device names.

Guarantee:

If your product becomes faulty within one year after its purchase while being used under good
conditions by observing "IMPORTANT" and "Precautions for Safety" described in this user's
manual, we will repair or replace your faulty product free of charge. Note, however, that if your
product's fault is raised by any one of the following causes, we will repair it or replace it with new
one with extra-charge:

- Misuse, abuse, or use under extraordinary conditions

- Unauthorized repair, remodeling, maintenance, and so on

- Inadequate user's system or misuse of it

- Fires, earthquakes, and other unexpected disasters

In the above cases, contact your local distributor.



Precautions for Safety

READ FIRST

Before using this product, be sure to read the user’s manual (this user's manual) carefully.

Keep this user’s manual, and refer to this when you have questions about this product.



DEFINITION OF SIGNAL WORDS

Be sure to read and understand the warnings below before using this emulator. Note that these are
the main warnings, not the complete list.

A This is the safety alert symbol. It is used to alert you to potential personal
injury hazards. Obey all safety messages that follow this symbol to avoid
possible injury or death.

A DANGER DANGER indicates an imminently hazardous situation which, if not

avoided, will result in death or serious injury.

A WARNING WARNING indicates a potentially hazardous situation which, if not
avoided, could result in death or serious injury.

|A CAUTION l CAUTION indicates a potentially hazardous situation which, if not
avoided, may result in minor or moderate injury.

| CAUTION |

CAUTION used without the safety alert symbol indicates a
potentially hazardous situation which, if not avoided, may result
in property damage.

NOTE emphasizes essential information.



A WARNING

1. Do not repair or remodel the emulator product by
yourself for electric shock prevention and quality
assurance.

2. Always switch OFF the host computer and user system
before connecting or disconnecting any CABLES or
PARTS.

Failure to do so will result in a FIRE HAZARD and will
damage the user system and the emulator product or will
result in PERSONAL INJURY. The USER PROGRAM will
be LOST.

3. Connect the connectors in the user system and in the
user interface cable by confirming the correct direction.

CAUTION

Place the host computer and user system so that no cable is
bent or twisted. A bent or twisted cable will impose stress on
the user interface leading to connection or contact failure.
Make sure that the host computer and the user system are
placed in a secure position so that they do not move during
use nor impose stress on the user interface.
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Section 1 Overview

The High-performance Embedded Workshop is a Graphical User Interface intended to ease the
development and debugging of applications written in C/C++ programming language and
assembly language for Renesas microcomputers. Its aim is to provide a powerful yet intuitive way
of accessing, observing and modifying the debugging platform in which the application is running.

The E8a emulator (hereafter referred to as the emulator) is a software and hardware development
support tool for application systems using the Renesas microcomputer. For applicable MCUs,
refer to the web site.

The main unit of the emulator is connected through the dedicated debugging interface to the user
system. The user system can be debugged under the conditions similar to the actual application
conditions. The emulator enables debugging anywhere indoors or out. The host computer for
controlling the emulator must be an IBM PC compatible machine with USB.

This manual describes the contents that comply with versions of the High-performance Embedded
Workshop 4.0 or later.

Figure 1.1 shows the system configuration using the emulator.

High-performance Emhbedded Warkshop

&

IUSB intatface
cable (1.9 m) User system

.,..-"'2__‘_. interface cable

YWindows®-compatible

hast computer Efa emulator

Lser system

Figure 1.1 System Configuration with the Emulator
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The emulator has three activation modes:

(1) Erase Flash and Connect

This mode is used to erase data of the MCU flash memory and activate the debugger. A
program for the emulator is also written to at the same time.

(2) Keep Flash and Connect

This mode is used to activate the debugger while retaining data of the MCU flash memory.
However, areas for the emulator program and vector areas used by the emulator will be
changed.

(3) Program Flash

This mode is used to activate the emulator as a simple programmer. Only the user program is
written to when the flash memory is downloaded (the emulator program is not written to).
Accordingly, in this mode, program debugging is not available.

The emulator provides the following features:

(1) Support for programming of Renesas’ 8- to 32-bit microcomputers

The emulator supports Renesas’ 8- to 32-bit microcomputers as the programming tool for the
flash memory.

(2) Support for low voltage

The lower limit of the operating voltage is reduced to 1.8 V. The emulator also supports the
microcomputer even if its programming voltage for the flash memory is low (reprogramming
of the flash memory depends on the voltage to reprogram the flash memory in the
microcomputer).

(3) Excellent cost-performance card emulator
Compactness and USB connection are obtained.
(4) Realtime emulation

Realtime emulation of the user system is enabled at the maximum operating frequency of the
MCU.

(5) Excellent operability

Using the High-performance Embedded Workshop on the Microsoft® Windows® 2000 or
Microsoft” Windows® XP operating system enables user program debugging using a pointing
device such as a mouse.

(6) Various debugging functions

Various break and trace functions enable efficient debugging. Breakpoints and break
conditions can be set by the specific window, trace information can be displayed on a window,
and command-line functions can be used.

(7) Debugging of the user system in the final development stage

The user system can be debugged under conditions similar to the actual application conditions.
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(8) Compact debugging environment

A laptop computer can be used as a host computer, creating a debugging environment in any
place.
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1.1 Warnings

CAUTION

READ the following warnings before using the emulator
product. Incorrect operation will damage the user system and
the emulator product. The USER PROGRAM will be LOST.

(1) Check all components against the component list provided at the rear side of the component
box after unpacking the emulator.

(2) Never place heavy objects on the casing.

(3) Protect the emulator from excessive impacts and stresses. For details, refer to section 1.2,
Environmental Conditions.

(4) When moving the host computer or user system, take care not to vibrate or damage it.

(5) After connecting the cable, check that it is connected correctly. For details, refer to section 3,
Preparation before Use.

(6) Supply power to the connected equipment after connecting all cables. Cables must not be
connected or removed while the power is on.
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1.2 Environmental Conditions

Observe the conditions listed in tables 1.1 and 1.2 when using
the emulator. Failure to do so will cause illegal operation in
the user system, the emulator product, and the user program.

CAUTION

Table 1.1 Environmental Conditions

Item

Specifications

Temperature

Operating: +10°C to +35°C
Storage: —10°C to +50°C

Humidity Operating: 35% RH to 80% RH, no condensation
Storage: 35% RH to 80% RH, no condensation
Vibration Operating: 2.45 m/s® max.
Storage: 4.9 m/s* max.

Transportation: 14.7 m/s® max.

Ambient gases

No corrosive gases may be present

Table 1.2 Operating Environments

Item

Description

Host computer

IBM PC or compatible machine with built-in Pentium® Il or higher-
performance CPU (600 MHz or higher recommended)

(OF]

Windows® 2000 or Windows® XP

Minimum memory
capacity

128 Mbytes or more (double of the load module size)

Hard-disk capacity

Installation disk capacity: 100 Mbytes or more. (Prepare an area at
least double the memory capacity (four-times or more recommended)
as the swap area.)

Interface

USB (USBH1.1, full-speed)*

Pointing device such as
mouse

Connectable to the host computer; compatible with Windows® 2000 or
Windows® XP.

Power voltage

5.0 + 0.25 V (USB-bus power type)

Current consumption

500 mA (max)

CD drive

Required to install the software for the emulator or refer to the emulator
user’'s manual.

Note: Can be connected to a host machine supporting USB 2.0.
Not all hardware (such as host machine, USB devices, and USB hub) combination will work

and guaranteed.
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1.3 Components

Check that all of the components are present when unpacking the product. For details on the E8a
emulator components, refer to the component list provided at the rear side of the component box.
If all of the components are not present, contact your nearest Renesas sales office.

RENESAS



Section 2 E8a Emulator Functions

This section describes the emulator functions. They differ according to the device supported by the
emulator.

2.1 Overview
Table 2.1 gives a functional overview of the emulator.

Table 2.1 Emulator Functions

No. Item Function

1 User program execution e Executes a program with the operating frequency within a
function range guaranteed by devices.

e Reset emulation

e Step functions:
Single step (one step: one instruction)
Source-level step (one step: one source)
Step over (a break did not occur in a subroutine)
Step out (when the PC points to a location within a
subroutine, execution continues until it returns to the calling

function)

2 Reset function e Issues a reset from the High-performance Embedded
Workshop to the device during break.

3  Trace function e Branch trace function incorporated in the device (four
branches)

The support of this function depends on a device.

4 Break functions e Hardware break condition (one condition)
The support of this function depends on a device.

e PC break condition (255 points)
e Forced break function
e Address match break function
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Table 2.1 Emulator Functions (cont)

No. Item

Function

5 Memory access function

Downloading to RAM
Downloading to flash memory
Single-line assembly

Reverse assembly (disassembly)
Reading of memory

Writing to memory

Automatic updating of a display of selected variables during
user program execution

FILL
Search
Move
Copy

6  General/control register
access function

Reads or writes the general/control register.

7 Internal 1/O register
access function

Reads or writes the internal I/O register.

8  Source-level debugging
function

Various source-level debugging functions.

9 Command line function

Supports command input.
Batch processing is enabled when a file is created by arranging
commands in input order.

10  Start/Stop function

Executes the specified routine of the user program immediately
before starting and immediately after halting program execution.

11 Help function

Describes the usage of each function or command syntax input
from the command line window.

The specific functions of the emulator are described in the next section.
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2.2 Trace Functions

The branch source addresses, mnemonics, operands, and source lines are displayed. Since this
function uses the trace buffer built into the device, a realtime trace can be acquired.

Note: The MCUs which have no trace function cannot use this function.

RENESAS



2.3 Break Functions
The E8a emulator has the following four break functions.

(1) Hardware break function
HS8 R8C series
Uses a break controller incorporated in the device.
The access address, instruction fetch address, data, or bus cycle condition can be set.

This function can also be set from the [Event] column in the [Source] window. For the setting,
refer to section 5.3.1 Address Interrupt Breakpoints.

Note: The MCUs which have no hardware break function cannot use this function.

(2) PC break function (BREAKPOINT)
Breaks when the dedicated instruction at the specified address that has been replaced is
executed.
This function can be set on the [Breakpoint] page in the [Eventpoint] dialog box. It can also be
set when the [S/W Breakpoints] column for the line to be set is double-clicked in the [Source]
or [Disassembly] window.

(3) Forced break function
Forcibly breaks the user program.

(4) Address match break function
Stops the target program immediately before a specified address instruction is executed. This
function is featured by the address match interrupt of the MCU. This function can be set from
the [Event] column in the Source window. For the setting, refer to section 5.2.2, Viewing the
Source Code.

Note: The address match break points vary depending on the device. And, user program
operation when device's address match interrupts are used is not guaranteed.
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2.4 Memory Access Functions
The emulator has the following memory access functions.

(1) Memory read/write function

[Memory] window: The memory contents are displayed in the window. Only the amount
specified when the [Memory] window is opened can be read. If the
memory is written in the [Memory] window, a read in the range
displayed in the [Memory] window will occur for updating the window.
When the [Memory] window is not to be updated, change the setting in
[Lock Refresh] from the popup menu.

me command: A command line function that reads or writes the specified amount of
memory at the specified address.

(2) User program downloading function

A load module registered in the workspace can be downloaded. Such module can be selected
from [Download Modules] in the [Debug] menu. Downloading is also possible by a popup
menu that is opened by right-clicking on the mouse at the load module in the workspace. The
user program is downloaded to the RAM or flash memory.

This function can download debugging information required for source-level debugging with
the Elf/Dwarf2 or IEEE69S file having the debugging information.

(3) Memory data uploading function

The specified amount of memory from the specified address can be saved in an S-format file.

(4) Memory data downloading function

The memory contents saved in the S-type-formatted file can be downloaded. Select [Load]
from the popup menu in the [Memory] window.

(5) Displaying the variable contents

The variable contents specified in the user program are displayed. For the usage of the function
for displaying the variable contents, refer to High-performance Embedded Workshop User’s
Manual.
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(6) Other memory operation functions

Other functions are as follows:

e Memory fill

e Memory copy

e Memory save

e Memory verify

e Memory search

e Internal I/O display

e Displaying label and variable names and their contents

Notes: 1. Memory access during user program execution:
When memory is accessed from the memory window, etc. during execution of the user
program, execution stops for the memory access and is then resumed. Therefore,
realtime emulation cannot be performed.

2. Memory access during user program break:
The program can also be downloaded and the BREAKPOINT can be set for the flash
memory area by the emulator.

2.5 Stack Trace Function

The emulator uses the information on the stack to display the names of functions in the sequence
of calls that led to the function to which the program counter is currently pointing. This function
can be used only when the load modules that have the following formats are loaded:

- M32C family C complier (M3T-NC308WA): IEEE695

- M16C family C compiler (M3T-NC30WA): IEEE695

- R8C series C compiler (M3T-NC8C): IEEE695

- H8,H8S,H8SX family C/C++ compiler (such as [ROC40008 XSWO6RY]): Elf/Dwarf2
For the usage of this function, refer to section 6.19, Stack Trace Function.

2.6 Start/Stop Function

The emulator executes the specified routine of the user program immediately before starting and
immediately after halting program execution. This function is used to control the user system in
synchronization with execution and halting of the user program.

For the usage of this function, refer to section 5.6, Using the Start/Stop Function.

Note: The start/stop function is not supported in the H8/Tiny or H8/Super Low Power series, the
740 family, or the R8C/10, R8C/11, R8C/12, or R8C/13 group.
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2.7 Online Help

An online help explains the usage of each function or the command syntax that can be entered
from the command line window.

Select [Emulator Help] from the [Help] menu to view the emulator help.

RENESAS
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Section 3 Preparation before Use

3.1 Emulator Preparation

Unpack the emulator and prepare it for use as follows:

A WARNING

READ the reference sections shaded in Figure 3.1 before
using the emulator product. Incorrect operation will damage
the user system and the emulator product. The USER
PROGRAM will be LOST.

Reference
Check the components against the component list
provided at the rear side of the component box
Set up the emulator Section 3
When the emulator
- Install the High-performance Embedded Workshop is uzec} fﬁs? ulato
- Connect the host computer to the emulator ’
- Connect the emulator to the user system
I -
| Start the High-performance Embedded Workshop | Section 4 When the emulator
| is used for second
| Turn on the user system | time or later.

Figure 3.1 Emulator Preparation Flow Chart
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3.2 Emulator Hardware Configuration

As shown in Figure 3.2, the emulator consists of an emulator, a USB cable, and a user system
interface cable. The emulator is connected to the host computer via USB 1.1, and also to the USB
port conforming to USB 2.0.

Eda
ernulatar
rmain unit

User system
interface cable

Figure 3.2 Emulator Hardware Configuration
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The names of each section of the emulator are explained next.

Emulator Upper-side Panel:

Figure 3.3 Emulator Upper-side Panel

(a) ACTLED: An LED to show the operating state of the emulator software.
When this LED is lit (yellow-green), the E8a control software is in
operation.

(b) VCCLED: An LED to show the power state of the user system.

When power is supplied from the emulator to the user system, this
LED is lit as orange.

When power is supplied from the user system to the emulator, this
LED is lit as yellow-green.

17
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Emulator Host-Computer-Side Panel:

Figure 3.4 Emulator Host-Computer-Side Panel

(a) Host-side connector: A USB cable connector to connect the emulator to the host
computer. Be sure to connect the provided USB cable.

(b) Portable strap hole: A hole for the strap (No strap is provided for this product).

18
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Emulator User-System-Side Panel:

Figure 3.5 Emulator User-System-Side Panel

(a)  User-system-side connector: A user system interface cable is connected.
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Emulator Bottom Panel:

St R

4 ~
- =

Figure 3.6 Emulator Bottom Panel

(a) Seal for product management: The serial number and a description of the emulator are
written on the seal. The actual written content will depend on
when you purchased the product.

20
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Emulator Left-Side Panel:

Figure 3.7 Emulator Left-Side Panel

(a) Self-check connector: A connector for the user system interface cable when the
E8aSCP (self-check program) is run.

(b) Cover for self-check connector: A cover for the self-check connector. Close this cover
when the E8aSCP is not run.

21
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3.3 Emulator Software Configuration

The following item is included with the emulator debugger when it is purchased:
e E8a Emulator Software: ROEOOO0O8 AKCEQOSR (CD)

331 CD

Install the software as instructed by the displayed messages by inserting the included CD into the
CD-ROM drive. The folders contain the files and programs listed below.

Table 3.1 Contents of the CD Directories

Directory Name Contents Description

Dlls Microsoft® runtime library A runtime library for the High-performance
Embedded Workshop. The version is checked
at installation and this library is copied to the
hard disk as part of the installation process.

Drivers E8a emulator driver The E8a emulator drivers.
Help Online help for the E8a An online help file
emulator
Manuals E8a emulator manual E8a emulator user's manual. This is provided
as a PDF file.
22
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3.4 Installing Emulator’s Debugger

When the CD is inserted in the host computer’s CD drive, execute HewInstMan.exe from the root
directory of the CD.

23
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3.5 Connecting the Emulator to the Host Computer

This section describes how to connect the emulator to the host computer. For the position of each
connector of the emulator, refer to section 3.2, Emulator Hardware Configuration.

Notes: 1. When [Add New Hardware Wizard] is displayed, select the [Search for the best driver
for your device. (Recommended)] radio button and then the [Specify a location] check
box to select the path to be searched for drivers. The location must be specified as
<Drive>:\DRIVERS. (<Drive> is the CD drive name.)

2. Be sure to install the emulator’s debugger before putting the emulator in place.

A WARNING

Always switch OFF the emulator product and the user system
before connecting or disconnecting any CABLES except for
the USB interface cable. Failure to do so will result in a FIRE
HAZARD and will damage the user system and the emulator
product or will result in PERSONAL INJURY.

The USER PROGRAM will be LOST.

24
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The emulator is connected to the host computer via the USB 1.1, and also to the USB port
conforming to USB 2.0. Figure 3.8 shows the system configuration.

 Z_4

II5H interface

cahle (1.5 m
Windows®-compatible I: )

host computer Ef&a emulator

Figure 3.8 System Configuration when Connecting the Emulator to the Host Computer
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3.6 Connecting the Emulator to the User System

Use the procedure below to connect the emulator to the user system with the user system interface
cable, or to disconnect them when moving the emulator or the user system.

1. Check that the host computer is turned off or the emulator is not connected to the host
computer with the USB cable.

2. Connect the user system interface cable to the user-side connector of the emulator.

3. Connect the USB cable to the host-computer-side connector of the emulator.

(1) The connector must be installed on the user system. Table 3.2 shows the recommended
connector for the emulator.

Table 3.2 Recommended Connector

Type Number Manufacturer Specifications

2514-6002 3M Limited 14-pin straight type

Note: When the connector is installed on the user system, do not install any components within 3
mm of the connector.

26
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(2) The pin assignments of the connector are shown in the section of ‘Pin Assignments of the
E8/E8a Connector’ in the additional documents for the E8a emulator user’s manual.

Wser systeminterface cable

/

Qonnect or

. User system
Pin 2

/

Pin 1

Figure 3.9 Connecting the User System Interface Cable to the User System

Notes: 1. To connect the signals output from the E8a connector, refer to the MCU pin

alignment.

2. Toremove the user system interface cable from the user system, pull the connector
upward.

3. The range of frequencies that the emulator operates at is different according to the
MCUs used.

4.  Connect the signals from the E8a connector as shown in section 3 or section 4 in
the additional documents for the E8a emulator user’s manual.
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3.7 Connecting System Ground

A WARNING

Separate the frame ground from the signal ground at the user
system. Failure to do so will result in a FIRE HAZARD and will
damage the user system and the emulator product or will
result in PERSONAL INJURY.

The emulator's signal ground is connected to the user system's signal ground. In the emulator, the
signal ground and frame ground are connected. In the user system, connect the frame ground only;
do not connect the signal ground to the frame ground (Figure 3.10).

Signal ground E8a emulator . . User system
Signal Signal
Logic '/ Logic
Host USB /\ /\ \
computer L / \ / \ |_ %
Signal ground Signal ground
Power
supply

Frame ground (

Figure 3.10 Connecting System Ground
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3.8 System Check

When the software is executed, use the procedure below to check that the emulator is connected
correctly. Here, use the workspace for a tutorial provided on the product.

Refer to section 4, Preparations for Debugging, for the other activating method to create a new
project or use a workspace for the High-performance Embedded Workshop of the old version.

1. Connect the emulator to the host computer.

2. Connect the user system interface cable to the connector of the emulator.

3.

4. Select [Renesas] -> [High-performance Embedded Workshop] -> [High-performance

Connect the user system interface cable to the connector in the user system.

Embedded Workshop] from [Programs] in the [Start] menu of Windows”
The [Welcome!] dialog box is displayed.

Welcome!

Cptions: oK |

| {« Lreate a new project workspace Cancel |
=

(" Qpen a recent project workspace: Adminiztration.. |

| [~

= Browsze to another project workspace

Figure 3.11 [Welcome!] dialog box

[Create a new project workspace] radio button: Creates a new workspace.

[Open a recent project workspace] radio button: Uses the current workspace and displays

the history of the opened workspace.

[Browse to another project workspace] radio button: Uses the current workspace; this radio

button is used when the history of the
opened workspace does not remain

To use a workspace for the tutorial, select the [Browse to another project workspace] radio button
and click the [OK] button.

RENESAS
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When the [Open workspace] dialog box is opened, specify the following directory:
<OS installation directory>

\WorkSpace\Tutorial\E8\xxxx\Tutorial
After the directory has been specified, select the following file and click the [Open] button.

Open Workspace E]

Lok, in: |Lf} Tutarial j = £k ER-
[ Tutorial

Ty torial, b

File name: |Tut0rial.hws
Files of bype: |HEW Woorkspaces [ hwsz) j Cancel

Figure 3.12 [Open Workspace] Dialog Box
Note:
The directory for a tutorial differs depending on the device.
® M32C
Drive where the OS has been installed:
\WorkSpace\Tutoria\E8a\M32C\Tutorial
® Mi6C
Drive where the OS has been installed:
\WorkSpace\Tutoria\E8a\M 16C\Tutorial
® R8C/Tiny
Drive where the OS has been installed:
\WorkSpace\Tutoria\E8a\R8C\Tutorial
® 740
Drive where the OS has been installed:
\WorkSpace\Tutorial\E8a\740\Tutorial
® HS8/Tiny normal mode
Drive where the OS has been installed:
\WorkSpace\Tutorial\E8a\H8\Tutorial
® H8/Tiny advanced mode
Drive where the OS has been installed:
\WorkSpace\Tutoria\E8a\H8\Tutorial ADV
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®  H8/Super Low Power
Drive where the OS has been installed:
\WorkSpace\Tutoria\E8a\H8\TutorialSLP

6. The [Emulator Setting] dialog box is displayed.

x]

Emulator Setting

Ermulatar mode l Firmware Location ] Communication Baud Rate ]

MG Group |RBG;’25 Giraup ﬂ
Device  [REF21258 =]
Mode (* Eraze Flazh and Connect

(" Keep Flash and Connect
" Proeram FElash
" Debugeging of GPU rewrite mode

-

Pomer supply
[ Power Target from Emulator. (WA% 300mas
{+ i

Cancel

[ Do not zhow this dialog box again.

Figure 3.13 [Emulator Setting] Dialog Box
Select the device name in use from the [MCU Group] drop-down list box.

Note: The [MCU Group] drop-down list box is not displayed in the H8/Tiny or H8/Super Low
Power series.

Select the device name in use from the [Device] drop-down list box.
The following items are selected in the [Mode] group box.

— Erase Flash and Connect

This mode is used to erase data of the MCU flash memory and activate the debugger. A
program for the emulator is also written to at the same time.
31
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Note:

The emulator occupies the user’s flash memory area according to the target MCUs. For
details, refer to the additional document, Notes on Connecting the XXxxx.

— Keep Flash and Connect

Note:

Note:

This mode is used to activate the debugger while retaining data of the MCU flash memory.
However, areas for the emulator program and vector areas used by the emulator will be
changed.

Program Flash

This mode is used when the emulator is used as a flash memory programmer. It cannot be
used for debugging programs.
Register the load module in the workspace to download it.

It is necessary to input the ID code of the flash memory by the target device. For details,
refer to the additional document, Notes on Connecting the XXxxXx.

Debugging of CPU rewrite mode

This mode is used to debug the program that rewrites the CPU. In this mode, the following
debug operations, which require reprogramming of the flash memory, are not available:

- Setting the PC breakpoint

- Changing the memory contents in the flash memory area

The debugger is activated by erasing data of the MCU flash memory. A program for the
emulator program is also written to at the same time.

This mode is not supported in the H8/Tiny or H8/Super Low Power series.

When the [Execute the user program after ending the debugger.] check box is selected, the user
program is executed at the same time as the debugger operation is ended with the emulator
connected to the user system. This check box is only available when the [Program Flash] mode

has been selected.

When the [Power Target from Emulator. (MAX 300mA)] check box is selected, power will be
supplied to the user system up to 300 mA. Then select 3.3 V or 5.0 V according to the power

voltage of the user system.
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CAUTION

Before carrying out the power supply, check the power
specification of the user system and there is no short circuit
in the user system. Incorrect operation will damage the user
system and the emulator product. The USER PROGRAM will
be LOST.

. The [Connecting] dialog box is displayed and the emulator connection is started.

Figure 3.14 [Connecting] Dialog Box

RENESAS
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8. When the version of the E8a firmware downloaded into the emulator is old, the message box
shown in Figure 3.15 will be displayed.

ESARBG

2 & newer version of Emulator firrwware i available.
x_':/ Update now?

Zancel

Figure 3.15 Dialog Box for confirming the E8a firmware download

Note: When [OK] button is clicked, it starts downloading the E8a firmware. Do not
connect/disconnect the USB cable until the download status dialog box closes.

9.  When [Power Target from Emulator. (MAX 300mA)] is not checked, the dialog box shown in
Figure 3.16 will be displayed.

E2ARBG

L] E Power on the tareet board and press <Enter:> Kew.
L

Zancel

Figure 3.16 Dialog Box of the Power-on Request Message

10. If no power is supplied to the user system, the dialog box for confirming the power supply
status of the user system will be displayed.

Power Supply

[ Power Tareet from Emulator. (WA% 300ma2

Zancel

Figure 3.17 [Power Supply] Dialog Box
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When no power is supplied from the emulator, click the [OK] button without selecting the [Power

Target from Emulator. (MAX 300mA)] check box.

When power is supplied from the emulator, select the [Power Target from Emulator. (MAX
300mA)] check box and select 3.3 V or 5.0 V according to the power voltage of the user system.

CAUTION

Before carrying out the power supply, check the power
specification of the user system and there is no short circuit
in the user system. Incorrect operation will damage the user
system and the emulator product. The USER PROGRAM will
be LOST.

RENESAS
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11. When "Connected" is displayed in the [Output] window of the High-performance Embedded
Workshop, the emulator initiation is completed

& Tutorial - High-performance Embedded Workshop

Fie Edit Yew Project Buld Debug Setup Iools Window Help

D Hd|2|sme||n ey 5
OWEne | "W EH|FRERAHPED
—

H@ e |[Debug R E8a SVSTE v | |[SessionieC_Eda SYSTEI =] | 74 & ‘
I

Bl

= [ Tutorial
=128 Assembly source
nert0.a30
=3 € source file
sait.c

= tutorial.c

=23 Download madu

o o] Tutorialx30

=3 Dependencies
sectdlling
“|Z] sarth

< | bl
T @e (@ 4]

Heoiotalal|gitl|s|eE]|?
Boot version "VER.1.00"

Efa firmware version "0.00.00.024"
Connected

Dizconnected

4 I DI\ Build )\Dehug Find in Files Macro & Test Wersion Control

7| [Defaull desktop | | NS [ A

Figure 3.18 High-performance Embedded Workshop Window

Note: When the user program has already been downloaded to the flash memory, source-level
debugging cannot be executed because there is no debugging information on the user
program after the emulator has been activated. Be sure to load the debugging information
file. For details, refer to section 4.2.1, Setting at Emulator Activation.
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Notes: 1. If the user system interface cable is disconnected from the connector on the user
system, the following dialog box will appear.

ES ARB G

Figure 3.19 [Connector disconnected] Dialog Box

2. If the emulator is not properly initialized, one of the dialog boxes shown in figures 3.20
through 3.24 will appear.

(a) The following dialog box is displayed when the flash memory cannot be erased.
Exchange the MCU since the flash memory has been programmed more times than
the limitation.

E8 ARBC

' Flazsh memory erase error!
= Chanee device.

Figure 3.20 [Flash memory erase error!] Dialog Box

(b) The following dialog box is displayed when the flash memory cannot be programmed.
An incorrect system clock value has been input or the flash memory has been
programmed more times than the limitation.
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E8 ARBC

' "_q,, Error sendine Flagh memory write program
L

Figure 3.21 [Error sending Flash memory write program] Dialog Box

(c) The following dialog box is displayed when an incorrect ID code has been input. For
the H8/Tiny, H8/Super Low Power, R8C/10, 11, 12 and 13, if an ID code does not
match, the flash memory will be completely erased.

ESARSC [X]

! "_'., ID code error !

Figure 3.22 [ID code error!] Dialog Box

(d) The following dialog box is displayed when the MCU cannot communicate with the
emulator. Check the MCU settings.

ESARSC X

! "_n,, Boot Failed !

Figure 3.23 [Boot Failed!] Dialog Box
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3. If an incorrect driver has been selected, the following dialog box will appear.

I EBARBC

! "_'., Pleaze chooze driver.

Figure 3.24 [Unable to restore the previous driver settings] Dialog Box
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3.9 Uninstalling the Emulator’s Debugger

Follow this procedure to remove the installed emulator’s debugger from the user’s host computer.
As the installed product is known by the High-performance Embedded Workshop, uninstall the
product on the High-performance Embedded Workshop screen.

1. Activate the High-performance Embedded Workshop.
2. Click the [Administration...] button in the [Welcome!] dialog box.

Welcome!
Cptions: oK |
J {« Lreate a new project workspace Cancel |
..‘J (" QOpen a recent project workspace: Administration... |
| [
iJ
j (" Browse to another project workspace

Figure 3.25 [Welcome!] Dialog Box

3. The [Tools Administration] dialog box is opened.

Tools Administration

Registered components:

Compaonent : | Wersion Cancel
+-[_] Toolchaing
(2 Spstem Tools

(23 Utiity Phases Begister.
+ D Debugger Components
4[] Extension Components

(23 Communication Tools

Search dizk.

Tool informatian. ..

e
IEEEE
T
[Ee=sdt |
ettt |
[ |

4 ‘ | e Urinstaller...

™ Show all components

Current HEW tools database location:

|G:\F’rogram Files\Renesas\Hew HModify

Figure 3.26 [Tools Administration] Dialog Box
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Click the [+] mark at the left of [Debugger Components] in the [Registered components] list
box to list the installed components. Then, highlight the product name to be uninstalled.

Tools Administration @@

Fiegistered components:
Compaonent | “ersion =] Cancel
A Generic Registers View ECx 3.00.00

4 Generic Siml0 Yiew ECX 5.05.00

# Generic StackTrace View ECX E.00.00 Register...
#4 Generic Status Wiew ECX 1.04.00 .

A Generic TLE Yiew ECR 1.03.00 Wi
24 Generic Trace View ECX 3.02.00 .

A Geneiic Trigger View ECX 20200 Eropeties. .
#4 Generic W atch View ECX 2.05.00

A4 Generic Waveform Yiew ECK 1.05.00 |

#4 |EEEE95 object reader 2.00.00 o
#¢ Intel Hex Record Object Reader 1.04.00 —

Faf FISCES TEH 2.00.00 Tool information. .
#¢ REBCTX Series CPU 2.00.00 =

) | A A P A e T et Pt nAn oo | , |_ Urinstaller..

[ Show all components

Current HE'W tools database location:

|G:\F‘rogram Files'Renesas\Hew Modify...

Figure 3.27 Highlighting the Product to be Uninstalled

Click the [Unregister] button. After the following message box is displayed, click the [Yes]
button.

High-perfor mance Embedded Worksho |

nregistering this tool removes it From the HEW' system; consequently, it
will not be available ko any HEW \WarkSpace.

Are you sure that you wank ko unregister ik ¥

Figure 3.28 [Unregistering this tool] Message Box

This is the end of canceling the High-performance Embedded Workshop registration. Then,
remove the file for the emulator from the host computer.

Click the [Uninstaller...] button in the [Tools Administration] dialog box to open the
[Uninstall HEW Tool] dialog box.
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Uninstall HEW Tool ?X]

Select the directary in which to begin the search far tools:

|E:\F'n:ugram Filez\FRenesashHew Browse. .

v |nclude subfolders

Located toals which can be uninstalled:

Component Wergioh | Installation Directony

J

| W

Search status:  |dle

Figure 3.29 [Uninstall HEW Tool] Dialog Box

Click the [Start] button to list the installed components.

Uninstall HEW Tool ? %]

Select the directory in which to begin the zearch for tools: Start

.

|C:\F‘rngram Files"\RenezaziHew Browsze...
_ Gl |
_ Lrivsah_|

v Include subfolders

Located tools which can be uninstalled:

Component Yerzion | Ingtallation Direchary Urunztall

20000 G:\Program Fi

Search status: 1 filefs] found

Figure 3.30 Highlighting the Product to be Uninstalled

42
RENESAS




Highlight the product name to be uninstalled and click the [Uninstall] button. This is the end of
uninstallation.

CAUTION

A shared file may be detected while the program is being
removed. If another product may be using the shared file, do
not remove the file. If another product does not start up after
the removal process, re-install that product.
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Section 4 Preparations for Debugging

4.1 Method for Activating High-performance Embedded Workshop
To activate the High-performance Embedded Workshop, follow the procedure listed below.

Connect the emulator to the host computer and the user system, then turn on the user system.

2. Select [Renesas] -> [High-performance Embedded Workshop] -> [High-performance
Embedded Workshop] from [Programs] in the [Start] menu of Windows”

3. The [Welcome!] dialog box is displayed.

Welcome!
Cptions: oK |
A (v Lreate a new project workspace! Cancel |
..‘J (" QOpen a recent project workspace: Administration... |
| [
J
—1 (" Browse to another project workspace

Figure 4.1 [Welcome!] Dialog Box
[Create a new project workspace] radio button: Creates a new workspace.

[Open a recent project workspace] radio button: Uses the current workspace and displays
the history of the opened workspace.

[Browse to another project workspace] radio button: Uses the current workspace; this radio
button is used when the history of the
opened workspace does not remain.

In this section, we describe the following three ways to start up the High-performance Embedded
Workshop:

e [Create a new project workspace] - a toolchain is not in use
e [Create a new project workspace] - a toolchain is in use
e [Browse to another project workspace]

The [Open a recent project workspace] radio button is used to omit the operation for specifying the

workspace file when [Browse to another project workspace] is selected.
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4.1.1 Creating the New Workspace (Toolchain Not Used)

1. In the [Welcome!] dialog box that is displayed when the High-performance Embedded
Workshop is activated, select [Create a new project workspace] radio button and click the

[OK] button.

Welcome!
Cptions: — |
J Lreate a new project workspace Cancel |
.// (" Open a recent project workspace: Adminiztration.. |
' =]
o
J (" Browse to another project workspace

Figure 4.2 [Welcome!] Dialog Box

2. The Project Generator is started. This section omits the description on the setting for the

toolchain.
If you have not purchased the toolchain, the following dialog box is displayed.
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Mew Project Workspace

Projects l

. Workzpace Mame:
Project Types Selbsp

%3 Debugger only - REC E8a 54" |tESt

FProject Marne:

|test

Directany:

|E:'\"v’-.-"u:urk5 pacehtest Browsze. .

CPU farmily:
IM16C |

T ool chain:

|N|:une ﬂ

< ! *

Properties...

Cancel
Figure 4.3 [New Project Workspace] Dialog Box
[Workspace Name] edit box: Enter the new workspace name. Here, enter ‘test’.
[Project Name] edit box: Enter the project name. When the project name is the same as

the workspace name, it needs not be entered.

[CPU family] drop-down list box: Select the target CPU family.
M32C: Select [M16C/80, M32C]
R8C, M16C: Select [M16C].
740: Select [740 Family].
HS8 Tiny/Super Low Power: Select [H8S, H8/300].

[Tool chain] drop-down list box: Here, select [None].

Other list boxes are used for setting the toolchain; the fixed information is displayed when the
toolchain has not been installed.
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3. The following dialog box is displayed.

Setting the Target System for Debugging

Target type ; I-"h-" Targets ﬂ

< Back I Mest » I Finizh | Cancel |

Figure 4.4 [Setting the Target System for Debugging] Dialog Box

Select the target system for debugging and click the [Next] button.

[Target system for debugging] [Target MCU]
M32C E8a SYSTEM: M32C

M16C E8a SYSTEM: M16C

R8C E8a SYSTEM: R8C/Tiny
740 E8a SYSTEM: 740

HS8 Tiny/Super Low Power E8a SYSTEM 300H: HS8/300H Tiny, H8/300H Super Low Power
HS8 Tiny/Super Low Power E8a SYSTEM 300L: HS8/300 Super Low Power

4. Set the configuration file name. The configuration file saves the setting of the High-
performance Embedded Workshop except the emulator.
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Setting the Debugger Options

Target name

Configuration name
|Debug_H AC_EBa 5vSTEM

— Detail options :

[kem | Walue

Fdmdify |

¢ Back I Hewt > Finizh | Cancel |

Figure 4.5 [Setting the Debugger Options] Dialog Box

This is the end of the emulator setting.

Click the [Finish] button to exit the Project Generator. The High-performance Embedded
Workshop is activated.

. After the High-performance Embedded Workshop has been activated, the emulator is
automatically connected. For operation during connection, refer to section 3.8, System Check.
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4.1.2 Creating the New Workspace (Toolchain Used)

1. In the [Welcome!] dialog box that is displayed when the High-performance Embedded
Workshop is activated, select [Create a new project workspace] radio button and click the

[OK] button.

Welcome!

Cptions: oK |

| f« Lreate a new project workspace Ciancel |

™~ Qpen a recent project workspace: Administration.. |

| [~

[
i g Browsze to another project workspace

Figure 4.6 [Welcome!] Dialog Box

2. The Project Generator is started.
If you have purchased the toolchain, the following dialog box is displayed.

New Project Workspace

Projects I

Project Types

@ Application

I@C source startup Application
Iﬁ Empty Application

5 Import Makefile

G Library

7 Debugeer only - REC E8 SYSTEN

Workspace Mame:

|test

Project Mame:

|test

Directory:

|O: WorkSpace i test

Browsze..

GPU family:

[M16C x|
Toal chain:

|Renesas MGG Standard ﬂ

¢ ' >

Properties..

Cancel

Figure 4.7 [New Project Workspace] Dialog Box
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[Workspace Name] edit box:
[Project Name] edit box:

[CPU family] drop-down list box:

[Tool chain] drop-down list box:

[Project type] list box:

Enter the new workspace name. Here, enter ‘test’.

Enter the project name. When the project name is the same
as the workspace name, it needs not be entered.

Select the target CPU family.

Select the target toolchain name when using the toolchain.
Otherwise, select [None].

Select the project type to be used.
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3. Make the required setting for the toolchain.

Mew Project-1/6-Select Tareet . Toolchain version

Toolchain version

|5.42.00 ]

hich CPU do vou want to use for this
project?
CPU Series:

M16C./30 el
M1BC/20 =
M1GCA0

M16C Tin E|
m o]

GPU Group:

=]
=1
|2

If there iz no GPU eroup to be selected,
select the “CPU Group” that a similar to
hardware specification or select “"Other”,

<Back [ MNext> |  Finish |  Gancel |

Figure 4.8 [New Project-1/6-Select Target CPU. Toolchain version] Dialog Box

Select your toolchain version, CPU series and click the [Next] button.
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4. Make the required settings for the RTOS.

New Project-2/6-Select RTOS

Tareget tvpe :
RTOS:  |none

Startup file tvpe IDefauIt

Startup files :

E-@ Project i'ﬂl
Ay G ozource file

=423 Azzembly source file il
3] nertnadn M
E [~ |
=43 Azsembly include file —|

- [E] sectIinc TV

[~ Show file path

<Back [ Mext> |  Finish Cancel

Figure 4.9 [New Project-2/6-Select RTOS] Dialog Box

Select the RTOS you use, type of startup file and click the [Next] button.

Note: In the H8/Tiny, H8/Super Low Power series, and 740 Family, this dialog box will not be

displayed.
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5. Make the required settings for the heap area etc.

New Project-2/6-Setting the Contents of Files to be Generated [?r;|

ihat kind of initialization routine
would vou like to create?

ROM zize: I "l

[ ilze Standard IO Library!

¥ Usze Heap Memary

Heap Size: IEIEEIH

Generate main® Function
iG gource file Li

<Back |[ MNext> |  Finsh | GCancel

Figure 4.10 [New Project-3/6-Setting the Contents of Files to be Generated] Dialog Box

Set the heap size etc. and click the [Next] button.

Note: In the H8/Tiny, H8/Super Low Power series, and 740 family, the content of the dialog box
will differ.
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6. Make the required setting for the stack area.

Mew Project-4/6-Setting the Stack Area

What are the stack settines?

—lUszer Stack Pointer :

Stack Size:

iEIBEIH

—Interrupt Stack Pointer :

Stack Size:
n20H

{Back |[ Mext> |  Finish |  Gancel

Figure 4.11 [New Project-4/6-Setting the Stack Area] Dialog Box

Set the stack size and click the [Next] button.

RENESAS
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7. When the tool chain settings have been completed, the following dialog box is displayed.

New Project-5/6-5etting the Target System for Debugging X|

— External Debugger :

Target type ; I RACTiry ﬂ

< Back | Mext » I Firizh | Cancel |

Figure 4.12 [New Project-5/6-Setting the Target System for Debugging] Dialog Box

Select the target system for debugging and click the [Next] button.

[Target system for debugging] [Target MCU]
M32C E8a SYSTEM: M32C

M16C E8a SYSTEM: M16C

R8C E8a SYSTEM: R8C/Tiny
740 E8a SYSTEM: 740

HS8 Tiny/Super Low Power E8a SYSTEM 300H: HS8/300H Tiny, H8/300H Super Low Power
HS8 Tiny/Super Low Power E8a SYSTEM 300L: H8/300 Super Low Power

Select another product, if necessary.
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8. Set a configuration file name. The configuration file saves the settings of the High-
performance Embedded Workshop except for the emulator.

Mew Project-6/7-5etting the Debugger Options

Target name

Configuration name
|Debug_H AC_EBa 5vSTEM

— Detail options :

[kem | Setting

Fdmdify |

¢ Back | et > I Finizh | Cancel |

Figure 4.13 [New Project-6/7-Setting the Debugger Options] Dialog Box

RENESAS
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9. Finally, confirm the file name you create.

New Project—7/7-Chaneine the File Names to be Greated

The following =ource files will be

generated:
File Na..._! Ext.. I Description
test o Main Program
ncrtld a30 Start up file

zectal [as: Start up file

[

I 3 >

Mext Finizh | Cancel

Figure 4.14 [New Project-7/7-Changing the File Names to be Created] Dialog Box

The files which will be generated by the High-performance Embedded Workshop are
displayed
If you want to change the file name, select and click it then enter the new name.

This is the end of the emulator settings.
Exit the Project Generator following the instructions on the screen. The High-performance
Embedded Workshop is activated.
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10. After the High-performance Embedded Workshop has been activated, connect the emulator.
However, it is not needed to connect the emulator immediately after the High-performance
Embedded Workshop has been activated.

To connect the emulator, use one of the methods (a) and (b) below. For operation during
connection, refer to section 3.8, System Check.

(a) Connecting the emulator after the setting at emulator activation

Select [Debug settings...] from the [Debug] menu to open the [Debug Settings] dialog box.

It is possible to register the download module or the command chain that is automatically
executed at activation. For details on the [Debug Settings] dialog box, refer to section 4.2,
Setting at E8a Emulator Activation.

After the [Debug Settings] dialog box has been set, when the dialog box is closed, the
emulator is connected.
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(b) Connecting the emulator without the setting at emulator activation
The emulator can be easily connected by switching the session file that the setting for the
emulator use has been registered.

5 test - High-performance Embedded Workshop

Fle Edt Wew Project Buld Debug Setup Tools Window ?°7(T) Help

Deda|e =8
—  -|x

B =
= test

=53 Assembly source

nert0.a30

=123 C source file

S - test.c

=23 Dependencies
sect30 inc

DefaultS

|| # & ||| 8 e X oo ] oatimn TR @ |

Find in Files “ersion Control

Ready FL 3| FZ[ ¥ Defaultl desktop NS
A

Figure 4.15 Selecting the Session File

In the list box that is circled in Figure 4.15, select the session file name including the character
string that has been set in the [Target name] text box in Figure 4.13, [New Project-6/7-Setting the
Debugger Options] dialog box. The setting for using the emulator has been registered in this

session file.

After selected, the emulator is automatically connected.
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4.1.3 Selecting an Existing Workspace

1. In the [Welcome!] dialog box that is displayed when the High-performance Embedded
Workshop is activated, select [Browse to another project workspace] radio button and click the
[OK] button.

Welcome!

Cptions: oK |

| " Lreate a new project workspace Cancel |
iJ

(" Qpen a recent project workspace: Adminiztration.. |

| [~

= Browsze to another project workspace

Figure 4.16 [Welcome!] Dialog Box
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2.

The [Open Workspace] dialog box is displayed. Select a directory in which you have created a
workspace.
After that, select the workspace file (.hws) and press the [Open] button.

Open Workspace E]
Loak. jr |lf} T utarial ﬂ . =k EF-
|2 Tutarial

ot Tukorial, hws

File narne: |Tutu:|rial.hws
Filez of lwpe: |HEW Wiorkspaces [ hws] j Cancel

3.

62

Figure 4.17 [Open Workspace] Dialog Box

This activates the High-performance Embedded Workshop and recovers the state of the
selected workspace at the time it was saved.

When the saved state information of the selected workspace includes connection to the
emulator, the emulator will automatically be connected. To connect the emulator when the
saved state information does not include connection to the emulator, refer to section 4.1.2,
Creating the New Workspace (Toolchain Used).
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4.2 Setting at E8a Emulator Activation

4.2.1 Setting at Emulator Activation

When the emulator is activated, the command chain can be automatically executed. It is also
possible to register multiple load modules to be downloaded. The registered load modules are
displayed on the workspace window.

1. Select [Debug Settings...] from the [Debug] menu to open the [Debug Settings] dialog box.

Debug Settings

| S ssionRiBC_EBa_STSTEM | Target | options |

[ Tutorial Target:
|RaC E8a SYSTEM |
Default debug format:
|IEEEESE_RENESAS ~|

Download modules:

Filename Offzet Address Format Add..
FICOMFIGDIRYSEPRO... 00000000 IEEEE35_REMES...

aali

Cancel

Figure 4.18 [Debug Settings] Dialog Box ([Target] Page)

2. Select the product name to be connected in the [Target] drop-down list box.

3. Select the format of the load module to be downloaded in the [Default Debug Format] drop-
down list box, then register the corresponding download module in the [Download Modules]
list box.

4. Click the [Options] tab.
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Debug Settings

|Sessi0nH8C_E8a_SYSTEM j Target Options

@ Tutorial Command batch file load timing:

Command line batch processing:

Add...

L

[ Do not perform autornatic target connection

¥ Download modules after build

[ Reset CPU after download module

[ Remove breakpoints on download

™ Dizable memory access until after karget connection command file execution

™ Limit dizassembly memary access

Ok | Cancel

Figure 4.19 [Debug Settings] Dialog Box ([Options] Page)

The command chain that is automatically executed at the specified timing is registered. The
following three timings can be specified:

e At connecting the emulator
e Immediately before downloading

o Immediately after downloading

Specify the timing for executing the command chain in the [Command batch file load timing]
drop-down list box. In addition, register the command-chain file that is executed at the specified
timing in the [Command Line Batch Processing] list box.
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4.2.2 Downloading a Program
A download module is added under [Download modules] in the [Workspace] window.

Open the load module of [Download modules] in the [Workspace] window by clicking the right-
hand mouse button and select [Download module] to start downloading the module.

lx]
E@ Tutorial
EI@ Tutorial
=23 © zource file
----- E fwectar.c
..... E heap_c
----- ] initsctc
----- ] intprec
----- E rezetpre.c
----- E sortc
----- E Tutarial.c
& Dowvwnload modules
D Tutaorial 20 L
3 Dependencies Download
. =] catartdefh Diovenload (Debug Data Onlyd
: -- initzcth Unload
rezetpreh
zorth Download & Mew Module..
typedefineh Remove
Debug Settings...
Canfigure Wiew..
| v Allow Dacking
Hide
Froperties...

@ij... @Temp... ENE T TIETTEETT “

Figure 4.20 Download Menu of the [Workspace] Window ([Projects])

Notes: 1. When load modules are downloaded, select [Debug] -> [Download] -> [All Download
modules].
2. The emulator downloads programs to the flash memory just before execution of the
user program.
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4.2.3 Setting the [Program Flash] Mode

The following describes the procedures when the emulator is used as the programming tool. The
load module to be downloaded to the new workspace is registered and programmed.

(a) Select the new project workspace.

Mew Project Workspace

Projects l

. Workzpace Mame:
Project Types Selbsp

. Diebugger only - RAC ERa 5 |tESt

FProject Marne:

|test

Directany:

|E:'\"v’-.-"u:urk5 pacehtest Browsze. .

CPU farmily:
IM16C |

T ool chain:

|N|:une ﬂ

< ! *

Properties...

Cancel

Figure 4.21 [New Project Workspace] Dialog Box
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(b) Select the target MCU and click the [Next] button.

Setting the Target System for Debugging

— Targets

Target bype : I-‘*‘-" Targets j

¢ Back I Hest > I Finizh | Cancel |

Figure 4.22 [Setting the Target System for Debugging] Dialog Box

RENESAS
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(c) Set a configuration file name and click the [Finish] button.

Setting the Debugger Options

Target name

18C EBa SYSTEM

Configuration name
|Debug_H AC_EBa 5vSTEM

— Detail options :

[kem | Walue

Fdmdify |

¢ Back I Hewt > Finizh | Cancel |

Figure 4.23 [Setting he Debugger Options] Dialog Box

RENESAS




(d) The [Emulator Setting] dialog box is displayed.

Emulator Setting [5__<|

Ernulator mode l Firrware Location ] Communication B aud B ate ]

MCU Group | RBC/25 Group |

Device |R5F21256 Bd

Mode | Erase Flash and Connect
" Keep Flash and Connect
" Program Flazh

" Debugging of CPU resrite mode

-

Poweer supply

v Power Target fror Emulator. [Ma 300maE
33 v 0%

k. | Cancel

[ Do nat show this dialog box again.

Figure 4.24 [Emulator Setting] Dialog Box

Select the [Program Flash] mode.

When the [Power Target from Emulator. (MAX 300mA)] check box is selected, power will
be supplied to the user system up to 300 mA. Then select 3.3 V or 5.0 V according to the
power voltage of the user system.
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(e) When [Power Target from Emulator. (MAX 300mA)] is not checked, the dialog box shown
in Figure 4.25 will be displayed.

I EBAREC

Cancel

Figure 4.25 Dialog Box of Power-on request message

When [Power Target from Emulator. (MAX 300mA)] is not checked, turn on the user
system.

(f) Enter the ID code printed on the flash memory.

I Gode verification

Pleaze input the ID code being written in the flash memory.

ID Code: |

Ihput Mode
{* Hex: Specify ID code by hexadecimal 14 digits.
i ASCIH : Specify ID code by ASCI character within 7 letters.

Cancel

Figure 4.26 [ID Code verification] Dialog Box

Note: Opening the [ID Code verification] dialog box in [Program Flash] mode depends on the
target device. For details, refer to the additional document, Notes on Connecting the
XXXXX.
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(g) Select [Debug Settings...] from the [Debug] menu.

gh-perfo bedded 0 op Ll
File Edit Wiew Project Setup Tools Test Window Help
DM@ | & Deugsesions.. I EL ) HJ@ 14 |[Debug RC E8a 5YSTE | [SessionfaC Ega SYSTELx] | 7 4 |
O o g e mupres. « |BP @B |0 8]
— [zTReset cru
EE=] =
S test Elge Fs
" 24 Downloac [l Reset Go Shift+FS
428 Depender [ oo 7o Corar
I Set PC To Cursor
Run...
o Display PC Cri4-Shift+y
T stepIn Fi1
T step Ower Fio
£ Step Cut Shift+F11
Step...
Step Mode »
@ Halt Program
Iritialize
! Connect
F Disconnect
<
B Save Memory..,
Verily Memory..,
B &
i OL Of Al At | Rl Download Modules 4
Eoot wersion ™ Unload Modules »
Efa firmware ve T
Connected
{I PI\ Build ADEI]I.IQ Find in Files Macro p Test Version Conkrol

Edit debug settings

7| F7| [Defaultl deskiop | [

[ ms [ T4

Figure 4.27 High-performance Embedded Workshop Window
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(h) Select the target MCU and then the download module with the [Add...] button.

Debug Settings
|SessionRiaC_ESa_SYSTEM »|  Target | Options |
I@ test Target:
|R8C EBa SYSTEM |
Default debug format:
| <honer j

Download modules:

Filename Offget Address | Format

[
|
[l

Ok | Cancel

Figure 4.28 [Debug Settings] Dialog Box ([Target] Page)

(1) The download file is displayed on [Projects].

= @ test
= I@ test

-3 Download modules

9 Dependencies

_@ijects @Templates “] Mavigation ]

Figure 4.29 [Workspace] Window ([Projects])
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() Select and download the file with the right-hand mouse button.

x|

= @ test
= I@ test

=423 Download modules

{3 Dep

Download module {debug data only)

Configure Yigw. ..

v Allow Docking
Hide

N @Pmiecls @Templates @1 Mavigation ]

Figure 4.30 Download Menu of the [Workspace] Window ([Projects])

(k) The dialog box for sum checking is displayed and writing is completed.

debugger

i Flash memaory writing QK.
' Sum daka=H'004350bc

Figure 4.31 Message for Completion of Flash Memory Writing
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(1) When the following dialog box is displayed, close and restart or exit the workspace.

debugger

] "_\ Please Restart or Exit
LJ

74

Figure 4.32 Message for Restarting or Exiting the [Program Flash] Mode
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Section 5 Debugging

This section describes the debugging operations and their related windows and dialog boxes. For
details on the common functions of the High-performance Embedded Workshop products, refer to
the High-performance Embedded Workshop User’s Manual.

5.1 Setting the Environment for Emulation

5141 Opening the [Configuration] Dialog Box

Selecting [Setup -> Emulator -> System...] or clicking the [Emulator System] toolbar button (@)
opens the [Configuration] dialog box.

75
RENESAS



5.1.2 [General] Page

Sets the emulator operation conditions.

Configuration

General
Device |REF21174 [~
Emulation mode |N|:urma| j
J=er interface B00000 by h
clock | - J
Flash memory |Disab|e j

zpnchronization

Cancel |

Figure 5.1 [Configuration] Dialog Box ([General] Page)
Items that can be displayed in the sheet are listed below.
[Device] combo box Displays the MCU name.

[Emulation mode] combo box Selects the emulation mode at user program execution.
Select Normal to perform normal emulation.

Select No break to disable PC breakpoint or break condition
settings during emulation.

[User interface clock] combo box Displays the transfer clock of the user interface.
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[Flash memory synchronization]
combo box

Selects whether or not the contents of the flash memory are
acquired by the emulator when the user program is stopped or
the position where the PC break is set is put back as the
original code.

When the flash memory is not programmed by the user
program, its contents need not be acquired by the emulator.

If there is no problem with the state that the program in the
flash memory has been replaced as the PC break code, the
position where the PC break is set needs not be put back as the
original code.

Disable: Read or program is not performed for the flash
memory except when the emulator is activated, the
flash memory area is modified, and the settings of
the PC break to the flash memory area are changed.

PC to flash memory: When the user program is stopped, the
specified PC break code is replaced as
the original instruction. Select this
option if there is a problem with the state
that the program in the flash memory
has been replaced as the PC break code.

Flash memory to PC: When the user program is stopped, the
contents of the flash memory are read by
the emulator. Select this option if the
flash memory is reprogrammed by the
user program.

PC to flash memory, Flash memory to PC:

When the user program is stopped, the contents of the flash
memory are read by the emulator and the specified PC break
code is replaced as the original instruction. Select this option if
the flash memory is reprogrammed by the user program and
there is a problem with the state that the program in the flash
memory has been replaced as the PC break code.

Note: This dialog box differs depending on products. For details, refer to the online help.
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5.2 Downloading a Program

This section describes how to download a program and view it as source code or assembly-
language mnemonics.

Note: After a break has been detected, the High-performance Embedded Workshop displays the
location of the program counter (PC). In most cases, for example if an Elf/Dwarf2-based
project is moved from its original path (at the build), the source file may not be
automatically found. In this case, the High-performance Embedded Workshop will open a
source file browser dialog box to allow you to manually locate the file.

5.21 Downloading a Program
A load module to be debugged must be downloaded.

To download a program, select the load module from [Debug -> Download] or select [Download]
from the popup menu opened by clicking the right-hand mouse button on the load module in
[Download modules] of the [Workspace] window.

Note: Before downloading a program, it must be registered to the High-performance Embedded
Workshop as a load module. For registration, refer to section 4.2, Setting at E8a Emulator
Activation.
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5.2.2

Viewing the Source Code

Select a source file name in the [Workspace] window and click [Open] in the popup menu to make
the High-performance Embedded Workshop display the source file in the editor. It is also possible
to display your source files by double-clicking on their names in the [Workspace] window.

B

L

woid tutorial (woid)

{

long al[l0]:

long j:;

int i:

Struct Sample far *p =am;

p saw= mwalloc{sizeocf(struct Sawple)):
init (p_sam) ;

for( i=0; i<10; i++ ) ¢{
i = rand():
if(j = 014
= -3:
H
alil = 3:
}
sort (a);
chahtge (a) 2

p_sam->s0=a[0] ;
p_sam->sl=all]:
b Sam->si=ali]:
p sam-rsi=al3]:

21
22 =194
23
z4
Z5
26
27
28 =197
29 elad
30
31 e1la9
3z elhd
33 ele0
3% eles
35
36 elce
37
35 eled
39 eleb
40
41 el1f2
4z elfe
43 =207
44 =212
tutarial.c

Figure 5.2 [Source] Window
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In this window, the following items are shown on the left as line information.
The first column (Line Number column) Line number
The second column (Source address column): Address information
The third column (Event column): Event information (break condition)

The fourth column (S/W Breakpoints column): PC, bookmark, and breakpoint
information

The right window that shows the source is called as the [Source] window.

e Line Number column

A line number for the current source file is displayed.

e Source address column

When a program is downloaded, an address for the current source file is displayed on the Source
address column. These addresses are helpful when setting the PC value or a breakpoint.

Event column

The Event column displays the following item:

®: An address condition as a break condition is set.
®: An address interrupt break is set.

This is also set by using the popup menu.

The bitmap symbol above is shown by double-clicking the Event column. This is also set by using
the popup menu.

Figure 5.3 Popup Menu

S/W Breakpoints column
S/W Breakpoints column displays the following items:
[ A bookmark is set.

@ A PC Break is set.
5*: PC location
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- To switch off a column in all source files

Click the right-hand mouse button on the [Source] window or select the [Edit] menu.
Click the [Define Column Format...] menu item.
The [Global Editor Column States] dialog box is displayed.

A check box indicates whether the column is enabled or not. If it is checked, the column is
enabled. If the check box is gray, the column is enabled in some files and disabled in
others. Deselect the check box of a column you want to switch off.

5. Click the [OK] button for the new column settings to take effect.

bl

Global Editor Golumn States

Event
[w]Lire Mumber Garcel
W= Breakpoints g
]S Breakpoints — &5M

[wlSource Address

Figure 5.4 [Global Editor Column States] Dialog Box

S To switch off a column in one source file
1. Open the source file which contains the column you want to remove and click the [Edit]
menu.
2. Click the [Columns] menu item to display a cascaded menu item. The columns are
displayed in this popup menu. If a column is enabled, it has a tick mark next to its name.
Clicking the entry will toggle whether the column is displayed or not.
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5.3 Stopping Your Program

This section describes how you can halt execution of your application's code. This section
describes how to stop the program by setting an address match breakpoints at specific locations in
your code.

5.3.1 Address Match Breakpoints

When you are trying to debug your program you will want to be able to stop the program running when
it reaches a specific point or points in your code. You can do this by setting the address match
breakpoint on the line or instruction at which you want the execution to stop. The following instructions
will show you how to quickly set and clear address match breakpoint.

e To set a PC breakpoint in the [Source] window

1. Make sure that the [Disassembly] or [Source] window is open at the place you want to set a PC
breakpoint.

2. Double-click in the event column at the line which you want the program to stop.

3 You will see a blue circle appear in the column to indicate that an address match breakpoint has
been set.

Now when you run your program and it reaches the address at which you set the address match
breakpoint, execution halts with the message "BREAK CONDITION" displayed in the [Debug] sheet
of the [Output] window, and the [Source] or [Disassembly] window is updated with the address match
breakpoint line marked with an arrow in the gutter.

Note: When a break occurs, the program stops just before it is about to execute the line or
instruction at which you set an address match breakpoint. If you choose Go or Step after
stopping at the address match breakpoint, then the line marked with an arrow will be the
next instruction to be executed.

About address match breakpoints, see also section 5.4.13, Setting Break Conditions.
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54 Using the Event Points

The emulator has the event point function that performs breaking by specifying higher-level
conditions along with the PC breakpoints standard for the High-performance Embedded
Workshop.

54.1 PC Breakpoints

When the instruction of the specified address is fetched, the user program is stopped. Up to 255
points can be set.

54.2 Break Conditions

Break conditions can be used for higher-level conditions such as the data condition as well as
specification of the single address.

54.3 Opening the [Event] Window

Select [View -> Code -> Eventpoints] or click the [Eventpoints] toolbar button () to open the
[Event] window.

The [Event] window has the following two sheets:

[Breakpoint] sheet: Displays the settings made for PC breakpoints. It is also possible to set,
modify, and cancel PC breakpoints.

[Breakcondition] sheet: ~ Displays or sets the settings made for break condition channels.

544 Setting PC Breakpoints

It is possible to display, modify, and add PC breakpoints on the [Breakpoint] sheet.

Type Itate Condition Action
Ereakpoint Ensble Address=El1CO(tutorial.c/33) EBreak

'\'Breakpointl,'{‘ Breakcondition l.-'r

Figure 5.5 [Event] Window ([Breakpoint] Sheet)
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This window displays and sets the breakpoints. Items that can be displayed in the sheet are listed
below.

[Type] Breakpoint
[State] Whether the breakpoint is enabled or disabled

[Condition] An address that the breakpoint is set
Address = Program counter (Corresponding file name, line, and symbol name)

[Action] Operation of the emulator when a break condition is satisfied
Break: Halts execution

When a breakpoint is double-clicked in this window, the [Set Break] dialog box is opened and
break conditions can be modified.

A popup menu containing the following options is available by right-clicking within the window.

545 Add

Sets breakpoints. Clicking this item will open the [Set Break] dialog box and break conditions can
be specified.

54.6 Edit

Only enabled when one breakpoint is selected. Select a breakpoint to be edited and click this item.
The [Set Break] dialog box will open and break conditions can be changed.

5.4.7 Enable

Enables the selected breakpoint(s).

5.4.8 Disable

Disables the selected breakpoint(s). When a breakpoint is disabled, the breakpoint will remain in
the list; when specified conditions have been satisfied, a break will not occur.

549 Delete

Removes the selected breakpoint. To retain the details of the breakpoint but not have it cause a
break when its conditions are met, use the Disable option (see section 5.4.8, Disable).

5.4.10 Delete All

Removes all breakpoints.
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5.4.11 Go to Source

Only enabled when one breakpoint is selected. Opens the [Source] window at the address of the
breakpoint.

5.4.12 [Set Break] Dialog Box

Set Break El El

Addiess l

Address H'O000ETC0

ok | Cancel

Figure 5.6 [Set Break] Dialog Box
This dialog box specifies break conditions.

A breakpoint address to be set is specified in the [Address] edit box. Up to 255 breakpoints can be
specified.

When [Address] is selected, if an overloaded function or class name including a member function
is specified in address, the [Select Function] dialog box opens.

Clicking the [OK] button sets the break conditions. Clicking the [Cancel] button closes this dialog
box without setting the break conditions.
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Notes on Setting the [Set Break] Dialog Box

1.

When an odd address is set for the H8/Tiny and H8/Super Low Power series, the address is
rounded down to an even address.

A Breakpoint is accomplished by replacing instructions. Accordingly, it can be set only to the
flash memory or RAM area. However, a software break cannot be set to the following
addresses:

— An area other than the flash memory or RAM

— An area occupied by the E8a emulator program

— An instruction in which Break Condition 1 is satisfied

During step execution, a software breakpoint is disabled.

A condition set at Break Condition 1 is disabled immediately after starting execution when an
instruction at a software breakpoint is executed. A break does not occur even if a condition of
Break Condition 1 is satisfied immediately after starting the execution.

When execution resumes from the breakpoint address after the program execution stops at the
software breakpoint, single-step execution is performed at the address before execution
resumes. Therefore, realtime operation cannot be performed.

Settings of software breakpoint and Break Condition 1 are invalid while the STEP OVER
function is being used.

5.4.13  Setting Break Conditions

On the [Breakcondition] sheet, the settings for break conditions are displayed, modified, and
added. For R8C/Tiny series, on the [Breakcondition] sheet, the settings for address match breakpoint
are displayed, modified, and added.

Type State Condition Action
E'E:re:ak condition Enable Address=E197 (tutorial. pchefore Break
Ereak condition Disshle Mone Ereak

Ereak condition Disshle HNone Eresk
Break condition Disable None Break

i Breakpoint }-‘Breakl:l:mdil:il:mI,-'r

Figure 5.7 [Event] Window ([Breakcondition] Sheet)

Note: The items that can be set in this window differ depending on the product. For the settings

for each product, refer to the online help.

This window displays and sets the break condition.
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Notes on Setting the Break Condition:

1. When [Go to cursor], [Step In], [Step Over], or [Step Out] is selected, the settings of Break
Condition 1 are disabled.

2. Setting of Break Condition 1 is disabled when an instruction to which a BREAKPOINT has
been set is executed.

3. When step over function is used, the settings of BREAKPOINT and Break Condition 1 are
disabled.

Notes on Setting the Break Condition (for the R8C/Tiny Series):

1. When [Go to cursor], [Step In], [Step Over], or [Step Out] is selected, the settings of Break
Condition are disabled.

2. Setting of Break Condition is disabled when an instruction to which a BREAKPOINT has been
set is executed.

3. Setting of BREAKPOINT is disabled when BREAKPOINT and Break Condition are set at
same address.

4. When step over function is used, the settings of BREAKPOINT and Break Condition are
disabled.

Items that can be displayed in the sheet are listed below.
[Typel] Break channel number

[State] Whether the breakpoint is enabled or disabled
[Condition] A condition that satisfies a break

[Action] Operation of the emulator when a break condition is satisfied
Break: Halts execution

When a breakpoint is double-clicked in this window, the [Break condition 1] dialog box is
opened and break conditions can be modified. For details on the [Break condition 1] dialog box,
refer to the online help for each product.

A popup menu containing the following options is available by right-clicking within the window.

54.14 Edit...

Only enabled when one breakpoint is selected. Select a breakpoint to be edited and click this item.
The [Break condition 1] dialog box will open and break conditions can be changed.

5.4.15 Enable

Enables the selected break channel(s). A break channel that the condition has not been set is not
enabled.
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5.4.16 Disable

Disables the selected break channel(s). When a break channel is disabled, a break will not occur
even if specified conditions have been satisfied.

5.4.17 Delete
Initializes the condition of the selected break channel. To retain the details of the break channel

but not have it cause a break when its conditions are met, use the Disable option (see section
5.4.16, Disable).

5.4.18 Delete All

Initializes conditions of all break channels.

5.4.19 Go to Source

Only enabled when one break channel is selected. Opens the [Source] window at address of break
channel.

If an address value has not been set to the break channel, this option cannot be used.

5.4.20 Sequential Conditions

Sets the sequential condition of the break channel.

5.4.21 Editing Break Conditions

Handlings for settings other than PC breakpoints and break conditions are common. The following
describes examples of such handling.

5.4.22 Modifying Break Conditions

Select a break condition to be modified, and choose [Edit...] from the popup menu to open the
dialog box for the event, which allows the user to modify the break conditions. The [Edit...] menu
is only available when one break condition is selected.

5.4.23 Enabling Break Conditions

Select a break condition and choose [Enable] from the popup menu to enable the selected break
condition.

5.4.24 Disabling Break Conditions

Select a break condition and choose [Disable] from the popup menu to disable the selected break
condition. When a break condition is disabled, the break condition will remain in the list, but an
event will not occur when the specified conditions have been satisfied.
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5.4.25 Deleting Break Conditions
Select a break condition and choose [Delete] from the popup menu to remove the selected break

condition. To retain the break condition but not have it cause an event when its conditions are met,
use the [Disable] option (see section 5.4.24, Disabling Break Conditions).

5.4.26 Deleting All Break Conditions

Choose [Delete All] from the popup menu to remove all break conditions.

5.4.27 Viewing the Source Line for Break Conditions
Select a break condition and choose [Go to Source] from the popup menu to open the [Source] or

[Disassembly] window at the address of the break condition. The [Go to Source] menu is only
available when one break condition that has the corresponding source file is selected.

5.4.28 [Break condition x] Dialog Box

Break condition 3

condition

Addrezs

[~ Don't care

* Address " Only program fetched address after

Address |H'45EI

Mask |N0n uzer mask j

HO
{+ i i
Read/wfiite
+ FeadMiite " Bead O wiite

ak. | Caticel |

Figure 5.8 [Break condition 3] Dialog Box
This page sets the address bus, data bus, and read/write cycle conditions.

Note: The items that can be set in this dialog box differ depending on the product. For the
settings for each product, refer to the online help.
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The [Address] group box sets address bus conditions.

Option Description

[Don’t care] check box Does not set address conditions.

[Address] radio button Sets the use of the normal address bus as break
conditions.

[Only program fetched address after] Sets a break after prefetched address execution as break

radio button conditions.

[Address] edit box Sets the address bus value with a number or a symbol.

[Mask] edit box Sets a value to be masked when [User mask] is selected.
For masked bits, the break condition is satisfied for any
values.

The contents of an option that can be will change depending on the radio button selected.

Option Description

[Address] radio button All options can be set.

[Only program fetched address after] The [Address] option can be set.
radio button

The [Data] group box sets the data bus conditions.

Option Description
[Don’t care] check box No data conditions are set.
[Value] edit box Sets the data bus with a number.
[Low byte] radio button Sets data access size as the lower 8-bit access.
[High byte] radio button Sets data access size as the upper 8-bit access.
[Word] radio button Sets data access size as the word access.

The [Read/Write] group box sets the read/write cycle conditions.

Option Description
[Read/Write] radio button Sets the read/write cycle conditions as break conditions.
[Read] radio button Sets read cycles as break conditions.
[Write] radio button Sets write cycles as break conditions.
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5.5 Viewing the Trace Information

For the description on the trace function, refer to section 2.2, Trace Functions.

551 Opening the [Trace] Window

To open the [Trace] window, choose [View -> Code -> Trace] or click the [Trace] toolbar button

().

5.5.2 Acquiring Trace Information

The acquired trace information is displayed in the [Trace] window.

12 BSE|E | |50
ETR IP Type Address Instruction Source | Label |
-000003 o003 ERANCH... OO00OE1E4... JSE.A _rand j = rand(};
-00000z 000z ERANCH... 0000ESE4... J2R.A _ idmuld

-000001 o001 ERANCH... O0O0ECS... RIS
| 0000 ERANCH... OODOESCD...

Figure 5.9 [Trace] Window

This window displays the following trace information items:

[PTR] Pointer to a location in the trace buffer (+0 for the last executed instruction)
[1P] The amount of acquired trace information
[Typel Type of branch:
BRANCH: branch source
[Address] Instruction address
[Instruction] Instruction mnemonic
[Source] The C/C++ or assembly-language source program
[Label] Label information

It is possible to hide any column not necessary in the [Trace] window. Selecting a column you
want to hide from the popup menu displayed by clicking the right-hand mouse button on the
header column hides that column. To display the hidden column, select the column from the said
popup menu again.

Note: The number of branch instructions that can be acquired by a trace and the trace display
differ depending on the product. For the specification of each product, refer to the online
help.
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553 Clearing the Trace Information

When [Clear] is selected from the popup menu, the trace buffer that stores the trace information
becomes empty. If several [Trace] windows are open, all [Trace] windows will be cleared as they
all access the same buffer.

554 Saving the Trace Information in a File

Select [Save...] from the popup menu to open the [Save As] file dialog box, which allows the user
to save the information displayed in the [Trace] window as a text file. A range can be specified
based on the [PTR] number. This file can only be saved; it cannot be reloaded into the [Trace]
window.

5.5.5 Viewing the [Source] Window

The [Source] window corresponding to the selected trace record can be displayed in the following
two ways:

e Select a trace record and choose [View Source] from the popup menu.
e Double-click a trace record

The [Source] or [Disassembly] window opens and the selected line is marked with a cursor.

5.5.6 Trimming the Source

Choose [Trim Source] from the popup menu to remove the white space from the left side of the
source.

When the white space is removed, a check mark is shown to the left of the [Trim Source] menu.
To restore the white space, choose [Trim Source] while the check mark is shown.
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5.6 Using the Start/Stop Function

The emulator executes the specified routine of the user program immediately before starting and
immediately after halting program execution. This function is used to control the user system in
synchronization with execution and halting of the user program.

Note: The start/stop function is not supported in the H8/Tiny or H8/Super Low Power series, the
740 family, or the R8C/10, R8C/11, R8C/12, or R8C/13 group.

5.6.1 Opening the [Start/Stop Function Setting] Dialog Box

The routine executed immediately before starting and immediately after halting the user program
execution is specified in the [Start/Stop Function Setting] dialog box.

To open the [Start/Stop Function Setting] dialog box, choose [Setup -> Emulator -> Start/Stop
Function Setting...] from the [Start] menu.

StartfStop Function Setting

[v The specified routing is executed immediately
befare execution of the user's program.

starting address | StatFuncstion ﬂ

[v The specified routing is executed immediately after
the stop of the user's program.

gtarting address |Stu:u|:uFunu:tin:un j

OF. | Canicel |

Figure 5.10 [Start/Stop Function Setting] Dialog Box

5.6.2 Specifying the Routine to be Executed

It is possible to specify the respective routines immediately before starting and immediately after
halting the user program execution.

When the [The specified routine is executed immediately before execution of the user’s program.]
check box is selected, the routine specified in the [starting address] combo box, which is below
this check box, is executed immediately before starting user program execution.
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If no specified routine is executed immediately before starting user program execution, do not
select the [The specified routine is executed immediately before execution of the user’s program.]
check box.

When the [The specified routine is executed immediately after the stop of the user’s program.]
check box is selected, the routine specified in the [starting address] combo box, which is below
this check box, is executed immediately after halting user program execution.

If no specified routine is executed immediately after halting user program execution, do not select
the [The specified routine is executed immediately after the stop of the user’s program.] check
box.
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5.6.3 Restrictions on the Start/Stop Function

The start/stop function has the following restrictions.

e Do not change the SFR used by the firmware.

e  When the watchdog timer is used, refresh the watchdog timer in the specified routine.
e Do not set any breakpoints in the specified routine.

e  When a stack is used in the specified routine, be sure to use the user stack.

e  Aregister value is undefined when execution of the specified routine is started. It is possible
to change the register value in the specified routine, however, the following register and flags
have restrictions.

Register and Flag Names Restrictions

ISP register When execution of the specified routine is ended, put the
value back to the one at the start of that routine.

Flag U Be sure to set the flag value as 0 when execution of the
specified routine is ended.

Flag B Do not set the flag value as 1 in the specified routine.

Flag | No interrupts are allowed during execution of the specified

routine. Do not set the flag value as 1 in the specified routine.

e When the content of the [Start/Stop Function Setting] dialog box is changed, the flash
memory will be reprogrammed in the block which the firmware has been allocated at user
program execution.

e  The specified routine is also executed when the following operations are performed:
— Step operations
— Watching or changing memory during user program execution
— Setting an event break during user program execution
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Section 6 Tutorial

6.1 Introduction
This section describes the main functions of the emulator by using a tutorial program.

The tutorial program is based on the C program that sorts ten random data items in ascending or
descending order. The tutorial program performs the following actions:

e The main function generates random data to be sorted.
e The sort function sorts the generated random data in ascending order.

e The change function then sorts the data in descending order.

The file tutorial . c contains source code for the tutorial program. The file Tutorial.x30
is a compiled load module in the IEEE695 format.

Notes:
1. After recompilation, the addresses may differ from those given in this section.

2. The file Tutorial . cpp contains source code for the tutorial program of the H8 family
devices. The file Tutorial.abs is a compiled load module in the Elf/Dwarf2 format.
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6.2 Running the High-performance Embedded Workshop

To run the High-performance Embedded Workshop, refer to section 3.8, System Check.

6.3 Setting up the E8a Emulator

This section describes the basic settings of the emulator.
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6.4 Setting the [Configuration] Dialog Box

o Select [Emulator] then [Systems...] from the [Setup] menu for the basic settings of the
emulator. The [Configuration] dialog box is displayed.

Configuration

General

Device |R5F21174

Ll L4

Emulation mode |N|:urma|

Uzer interface B00000 b
clock, | * ﬂ
Flazh memoary |Di$able j

zpnchronization

Cancel

Note:

Figure 6.1 [Configuration] Dialog Box

The items that can be set in this dialog box differ depending on the product. For the
settings for each product, refer to the online help.
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Set options as follows:

Table 6.1 [General] Page Options

Option Value
Device Select a device you use
Emulation mode Normal (normal execution, default)
User interface clock According to the system clock frequency, the maximum user

interface clock is automatically set.

Flash memory synchronization Disable (default)

Click the [OK] button to set a configuration.
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6.5 Checking the Operation of RAM

Check that RAM is operating correctly.

Display and edit the contents of the memory in the [Memory] window to check that the memory is
operating correctly.

Note: The memory can be installed on the board in some microcomputers. In this case, however,
the above way of checking the operation of memory may be inadequate. It is
recommended that a program for checking the memory be created.

e Select [Memory...] from the [CPU] submenu of the [View] menu and enter the RAM address
in the [Display Address] edit box. Here, enter ’0480°. Then, enter ‘0000’ and ’FFFF’ in the
[Scroll Start Address] and [Scroll End Address] edit boxes, respectively.

Display Address El E|

Dizplay Address: 0450 &
Scrall Start Address;  |0000 i
Scroll End Address:  |FFFF =

()4 | Cancel ‘

Figure 6.2 [Display Address] Dialog Box

Note: The settings of the RAM area differ depending on the product. For details, refer to the
hardware manual.

e (lick the [OK] button. The [Memory] window is displayed and shows the specified memory
area.
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p 1m 6 040 B 2 | abe; hodp dg | £ 4 36 .32 &

2ddress | Label| Register +0 +1 42 +3 +4 +5 +6 +7 +8 +9 +A B +C 4D +E +F ~
0480 10 F5 pZ 01 FE &AC ¢35 15 31 p8 10 F5 c¢8 01 FE A2

0430 F5 4c 03 F5 EF 00 FS 00 01 73 03 F5 Za 01 pl 23

0420 6E 02 E4 11 6a 40 F4 4B 03 73 0a 09 F5 19 01 73

04E0 0a& DB 77 53 04 00 DO OL A0 AZ 09 a0 AZ Oa& a0 az

04co OB a0 a2 0OC DO 04 F5 FF 00 73 0OC¢ 3& 03 a0 0z a0

0400 1z ¢3 24 77 53 0z 00 DL 23 &E EC FS Ea 00 ¢O 02

04ED 6E 15 FS BZ 0Ol 51 30 6% 18 FS F3 02 FE &6 0D 30

04F0 F5 E¢ 02 F4 3D FF ¢5 91 31 03 10 F5 58 01 FE 094

0500 5 a3 31 DI 10 F5 4E Ol F4 28 FF 73 A4 3a 77 24

0510 00 FF 72 a3 3¢ 75 ¢3 40 00 AR 3R 03 F5 3p 00 75

0520 c0 02 01 F5 FE OO0 72 1z F5 Obp 01 72 0z F5 08 O1

0530 75 cO0 80 00 F5 2E OO0 AR 3R 03 75 ¢3 40 00 FS 1B

0540 00 F5 ED OO0 75 c0 80 00 FS 1a 00 74 ¢z a5 FS E7

0550 00 74 c2 81 F5 EL OO0 F4 D3 FE PS5 75 0D 7D E8 FS v

Figure 6.3 [Memory] Window

e Placing the mouse cursor on a point in the display of data in the [Memory] window and
double-clicking allows the values at that point to be changed. Data can also be directly edited
around the current position of the text cursor.
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6.6 Downloading the Tutorial Program

6.6.1 Downloading the Tutorial Program

Download the object program to be debugged.

In this emulator, it is enabled to download the program and set the PC breakpoint in the internal
flash memory area. For the method to set the PC breakpoint, refer to section 6.16.1, PC Break
Function.

e Select [Download] from [Tutorial.x30] under [Download modules].

2
E@ Tutorial
EI@ Tutorial
=23 © zource file
----- E fwectar.c
..... 2] heapc
----- ] initsctc
..... Ea intpre.c
----- E rezetpre.c
----- E sortc
----- E Tutarial.c
I'_-'I‘a Download modules
D Tutorialx30 — O
Ea Dependencies Download
. ] catartdeth Diovenload (Debug Data Onlyd
initzcth Unload
resetprah
zarth Download A Mew Module..
5] typedetineh Remove
Debug Settings..
Configure View...
| v Allow Dacking
Hide
Properties...

@ij... @Temp... ENE T TIETTEETT “

Figure 6.4 Downloading the Tutorial Program
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6.6.2 Displaying the Source Program

The High-performance Embedded Workshop allows the user to debug a user program at the
source level.

e Double-click [tutorial.c] under [C source file].

Zl=
= @ Tutorial = &E‘l @
= @ Tutorial -
=53 G source fils Line So.. | E.| 5. Source
fvectorc 13
heap.c }g 150 \{foid mainivaid)
!“:‘SC‘-C 16 |E1a0 while (134 0
ntpre.c 17 |E184 tutorial();
resetprec 18 |E147 i
[ sorte 19 |E139 }
e 20
Ugtoi=lie 21 void tutorial(void)
-3 Download modules 29 |E194 I
Tutorial <30 - 0000 23 long al10];
-3 Dependencies gg !D?glj:
int i:
.csttartdef_h 28 struct Sample far #p_sam;
initzcth a7
resetpreh 28 [E13D p_zam= malloc(sizeof (struct Sampled);
zarth 29 |E1AE init{p_sam);
: a0
typedefineh 31 |E185 fort i=03 i<10; i++ )]
32 |E1CO i = rand();
24 |Etor AT
1= -13
3h 1
36 |E1DA , alil = i;
1| | » | <
n S J ISR = ‘ % Tutoriale

Figure 6.5 [Source] Window (Displaying the Source Program)

Select the [Display] option from the [Setup] menu to set a font and size that are legible, if
necessary.

Initially the [Source] window shows the start of the user program, but the user can use the scroll
bar to scroll through the user program and look at the other statements.
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6.7 Setting a PC Breakpoint
A PC breakpoint is a simple debugging function.

The [Source] window provides a very simple way of setting a PC breakpoint at any point in a
program. For example, to set a PC breakpoint at the sort function call:

o Select by double-clicking the [S/W Breakpoints] column on the line containing the sort
function call.

IExl=
Line So. | E.l 5. Source
21 woid tutorial (void)
22 [E194 1
aa lanz al10];
24 long j:
2h int i:
26 ztruct Sample far ®p_sam;
27
28 |E13D p_zam= malloc(zizeof (struct 3ample)):
29 [E1AE initip_sam);
a0
31 |E1BA farf i=0; i<10; i++ )
a2 (E1C0 I = rand();
33 [E1CC if(i < 0
34 [E1D1 = -i:
15 h
a6 [E1DA alil = i:
ar 1
a8 (E1FD $ sortia):
21 |E1F7 changelal;
40
41 |E1FE F_sam-»=s0=a[0];
42 |E208 p_zam-»=z1=all1];
43 |E213 p_zam-rs?=a[2]:
44 |EZ1E p_sam->33=a£31;
<]

ol Tutarialc

Figure 6.6 [Source] Window (Setting a PC Breakpoint)

The symbol e will appear on the line containing the sort function. This shows that a PC
breakpoint has been set.
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6.8 Setting Registers
Set values of the program counter and the stack pointer before executing the program.

o Select [Registers] from the [CPU] submenu of the [View] menu. The [Register] window is
displayed.

0 BAMK - Register 9]

Name | Value Radix
RO aooo Hex
Rl aooo Hex
RZ aooo Hex
R3 aooo Hex
A0 aooo Hex
Al aooo Hex
FE aooo Hex
PC OER1Z Hex
INTE 00000 Hex
UsF ooao Hex
I5P O5FF Hex
53] aooo Hex
1en| v] 1] o| 8| 5] 2| p|¢] |
0 oooOdoODOD

Figure 6.7 [Register] Window

106
RENESAS




To change the value of the program counter (PC), double-click the value area in the [Register]
window with the mouse. The following dialog box is then displayed, and the value can be
changed. Set the program counter to 0E612 in this tutorial program, and click the [OK] button.

PC - Set Value

Walue : |OEE12
Radis : |HEH ﬂ

Seths |'W'hu:-|e Reqgister ﬂ

] | Cancel

Figure 6.8 [Register] Dialog Box (PC)
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6.9 Executing the Program
Execute the program as described in the following:

e To execute the program, select [Go] from the [Debug] menu, or click the [Go] button on the
toolbar.

B

Figure 6.9 [Go] Button
When the program execution is started, ‘* *RUNNING’ is displayed on the status bar.

The program will be executed up to the breakpoint that has been set, and an arrow will be
displayed in the [S/W Breakpoints] column to show the position that the program has halted, with
the message [BREAKPOINT] in the status bar.

Note: When the source file is displayed after a break, a path of the source file may be inquired.
The location of the source file is as follows:
The High-performance Embedded Workshop is installed to:
\WorkSpace\Tutorial\E8a\xxxx\Tutorial\Tutorial\Source

The directory xxxx varies depending on each device.
e.g.: M32C
\WorksSpace\Tutorial\E8a\M32C\Tutorial\Tutorial\Source

e.g.: M16C
\WorksSpace\Tutorial\E8a\M 16C\Tutorial\Tutorial\Source

e.g.: R8C/Tiny
\WorksSpace\Tutorial\E8a\R8C\Tutorial\Tutorial\Source

e.g.: 740
\WorksSpace\Tutorial\E8a\740\Tutorial\Tutorial\Source

e.g.: H8/Tiny normal mode
\WorksSpace\Tutorial\E8a\H8\Tutorial

e.g.: H8/Tiny advanced mode
\WorksSpace\Tutoria\E8a\H8\Tutorial ADV

e.g.: H8/Super Low Power
\WorksSpace\Tutoria\E8a\H8\Tutorial SLP
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E.| 5. Source

far( i=0; <10y i++ )
io= rand();
ifii <03
= o-0
alil = i:

i
& sort(al;

change(a):

p_zam->s0=a 0]
p_sam->zl=alll:
p_sam-rsi=al2]:
p_zam->si=al[3]:
p_sam->sd=a[4];
p_zam->»sb=al6]:
p_sam->»sB=a[B]:
p_sam->s7=al7];
p_zam->sl=a8]:
p_sam-»zd¥=aldl;:
free(p_san);

p_sam = NULL:

4l Tutorialo J

Figure 6.10 [Source] Window (Break State)
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The user can see the cause of the break that occurred last time in the [Status] window.

e Select [Status] from the [CPU] submenu of the [View] menu. After the [Status] window is
displayed, open the [Platform] sheet, and check the Status of Cause of last break.

Itatus
Connected to: ROC Efa 3IYITEM (Renesas Communications)
CPT BSFZ21xxx

Fun status Feady

Cause of last break BEREALE FOINT

Fun time count O000hO00min000=343ms

Emulation mode MNormal

Little

Item

Platform r'(. Events r"'

Figure 6.11 [Status] Window

Note: The items that can be set in this window differ depending on the product. For the settings
for each product, refer to the online help.

110
RENESAS




6.10 Reviewing Breakpoints
The user can see all the breakpoints set in the program in the [Event] window.

o Select [Eventpoints] from the [Code] submenu of the [View] menu. The [Event] window is
displayed. Select the [Breakpoint] sheet.

2]

Type | State I Condition I Action
JEreakpoint Enable Address=E1F0 [Tutorial.c/38) Ereak

£ | >

4 ' Breakpoint A Breakcondition ‘,{

Figure 6.12 [Event] Window

The popup menu, opened by clicking the [Event] window with the right-hand mouse button
allows the user to set or change breakpoints, define new breakpoints, and delete, enable, or
disable breakpoints.

RENESAS

]

111




6.11 Viewing Memory

When the label name is specified, the user can view the memory contents that the label has been
registered in the [Memory] window. For example, to view the memory contents corresponding to
_main in word size:

e Select [Memory ...] from the [CPU] submenu of the [View] menu, enter _main in the
[Display Address] edit box, enter 0000 and FFFF in the [Scroll Start Address] and [Scroll End
Address] edit boxes, respectively.

Display Address E]

Dizplay Address: _main w2
Scroll Start Address: 0000 &
Scroll End Address:  |FFFF 7

Ok, | Cancel |

Figure 6.13 [Display Address] Dialog Box

e (lick the [OK] button. The [Memory] window showing the specified area of memory is
displayed.

o6 00 B 2 el £ a 2632 [T
fddress | Label | Register | 40 41 42 +3 +4 +5 +§ +7 +8 +3 +4 +B +C +0 +E +F | ASCII |~
E190 |_main D8 10 B4 06 F5 05 00 FE F8 F3 7C F2 30 7D E2 00 ..jeweuew. |.0}.. &
E140 00 70 E2 28 00 FD ¥4 E2 OO0 Y0 B4 73 OB FE 73 Bl .l.i..z..lisa.s.
E1ED FE FD 16 E0 00 D9 0B FC 77 8B FC 0& 00 VD CA& 31 ........ Woraelal
E1CH FO 12 E5 00 70 F% 7% 2B FA& 78 (B F8 7E BE DF B4 ....|.st.s..7..]
E100 04 75 7B F& 75 BB F& 77 EB F& 73 BO FC E3 10 EB .uf.ulow..=.....
E1ED 4B DO A1 04 73 BE F8 73 BE FA 02 C3 1B FC FE C3 K.ouseuSevannns
E1FD 0o 1B DO FD 78 E0O 00 EB 1B DO FD 34 E1 00 73 B4 ....¥eeeuos 4..=.
E200 | FE 73 BE D0 73 BB D2 02 73 B4 FE 73 B2 D4 04 72 .5iuSeesZauSen.s
EX10 B: D& O 73 B4 FE 73 B8 D8 08 73 B8 D& 04 73 Bd ...sc.sce.3e..se
EZ20 FE 73 B8 DC OC 73 B8 DE OE 73 B4 FE 73 B& E0 10 .s...3:...5..3...
E230 73 0BS OE2 12 73 B4 FE 73 BS E4 14 73 B8 EE 16 73 =...5..8...85...% -

Figure 6.14 [Memory] Window
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6.12 Watching Variables

As the user steps through a program, it is possible to watch that the values of variables used in the
user program are changed. For example, set a watch on the long-type array a declared at the
beginning of the program, by using the following procedure:

e Click the left of displayed array a in the [Source] window to position the cursor.

o Select [Instant Watch...] with the right-hand mouse button.

The following dialog box will be displayed.

Instant Watch

+-a {0«00045e } (=igned long[10]

Figure 6.15 [Instant Watch] Dialog Box

e C(lick the [Add] button to add a variable to the [Watch] window.

R D“}{ &R.

Name | Value Type
+ [ g I 0x000452 ) [zigned long[l07])

Watch1 f, Watchz j Watch3 j Watchd [

Figure 6.16 [Watch] Window (Displaying the Array)
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The user can also add a variable to the [Watch] window by specifying its name.

o Click the [Watch] window with the right-hand mouse button and select [Add Watch...] from
the popup menu.

The following dialog box will be displayed. Enter variable 1.

Add Watch

Wariable or expression: IR

i Cancel

Figure 6.17 [Add Watch] Dialog Box

e (Click the [OK] button.

The [Watch] window will now also show the int-type variable i.

R o X & P

Name |‘.falue Type
+ R g I O0x000452 ) [signed long[10])

H'ODDa { OxO0048=a ) [=igned int)

Watch1 /4 Wwatchz f watch j watche [

Figure 6.18 [Watch] Window (Displaying the Variable)
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The user can click mark ‘+ at the left side of array a in the [Watch] window to watch all the

elements.

R e d X | & &

Neaane |Value Type

5B/ oa I Ox00045e } (=igned long[10])
B [o] H'O0O0041z6 { OxO0O0045= } [signed long)
B [1] H'OOOO16%7e { Ox00046Z 1} (=igned long)
B [z2] H'ODOOOZT781 { Ox000466 3 [signed long)
B [2] H'ODOO346h { Ox00046a 3} (=igned long)
B [4] H'ODOO794k { Ox00046e 3} [signed long)
B [5] H'O0OO15fh { Ox000472 3 (=igned long)
B [6] H'00OOS9=2 { Ox000476 3} [signed long)
B [7] H'OOOO1lctkh { O=x0004%7a 3 (=igned long)
B [s] H'ODOO3If534 { Ox00047e 3} [signed long)
B [9] H'ODOOOffE { Ox0O048Z2 1} (=igned long)

B i H'OOO=a { O0x00043a 1} [signed int)

Watch1 j Wwatchz f watchd j, watche [/

Figure 6.19 [Watch] Window (Displaying Array Elements)
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6.13 Stepping Through a Program

The High-performance Embedded Workshop provides a range of step menu commands that allow
efficient program debugging.

Table 6.2 Step Option

Menu Description
Command P
Step In Executes each statement, including statements within functions.
Step Over Executes a function call in a single step.
Step Out Steps out of a function, and stops at the statement following the statement in the
program that called the function.
Step... Steps the specified times repeatedly at a specified rate.

6.13.1 Executing [Step In] Command

The [Step In] command steps into the called function and stops at the first statement of the called

function.

e To step through the sort function, select [Step In] from the [Debug] menu, or click the [Step
In] button on the toolbar.

#

Figure 6.20 [Step In] Button

5 &)\ &
Line So0. | E. 5. Source

17 |E051 p_sam->sb = 0;

18 (E0GA p_zam->zf = 0

19 |E0E3 p_sam->s8 = 0;

20 |EDEC p_zam->z8 = 0;:

21 |EOTE 1

22

23 sort{long #a)

24 |EOTH =3

25 long t:

26 int i, J, k., zap:

27

28 |EOTE zap = §;

29 |E0#1 whilel gap > 0 J1{

30 |E0BA for( k=0; kdzgap: k++){

31 |E047 for( i=ktzgap; €103 i=itzap )1

32 |E0A7 for(i=i-gap; i»=k: j=j-zapli

13 |EOBE if{alil>alitgar] }{

34 |EODY t = alil;

ar IFAFR alil = ali4sanl-
4

<l Tutoriale o7 zortc

Figure 6.21 [Source] Window (Step In)
e The highlighted line moves to the first statement of the sort function in the [Source] window.
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6.13.2 Executing [Step Out] Command

The [Step Out] command steps out of the called function and stops at the next statement of the
calling statement in the main function.

e To step out of the sort function, select [Step Out] from the [Debug] menu, or click the [Step

Out] button on the toolbar.

Note:

It takes time to execute this function. When the calling source is clarified, use [Go To

Cursor].

(7]

Figure 6.22 [Step Out] Button

utorial - Hieh—performance Embedded Workshop — [Tutorialc]

« File Edit View Project Build

Debug  Setup

Tooks Test Window Help

Dwdd B || B2 8 B gy ) [Debug REC_Faa_SVSTE v | |[Sessonfiel_E8a_SYSTEL || 4 4%
Ll 8 2 " O ETELE L Rl == = e = L=
=
=3 Tutorial = &&3
7 E [m &l
= ine | So0. | E.J 5. Source
o L ENEEE |
22 |E19%
2% long al101: Z‘
24 long I
25 int i
26 struct Sanple far #p_sams
27
28 [E19D p_san® nalloc{sizeof (struct Sample));
29 [ET4E init{p_san;
30
= 31 |EIBS
Tutorial30 - 0000 3z [EICD
= 23 Dependencies 3% |EICC
cstartdeth S |
initscth 36 E1D4
resetpreh a7
sarth 38 EIFD| (@ sort(a);
typadefineh 33 EIF?| | &|  chanzelal:
41 |EIFE p_san->s0=a[0];
42 |E208 p_san->s1=a[1]
13 |E218 p_sam->s2=al2]
44 |E21E p_san->s3=a[3]
45 |E228 psan->sd=a[4]
46 |E234 P Zsan->s57a[5]
47 |E23F p_san->s6a[6]
43 |E244 p_san->s7=a[7]
19 |E255 p_san->s8=a[8]
50 |E2E0 p_san-3s8=a [0];

< R

@ [Er. (@A [E.

ll

e Tutorials |=0=  sorte

iR [ A A @ ||
Hame | value | Type ||| | [FESET cPO ~
EN-IN { Ox00D45e } (signed long[10] iaf’: MEKOTY W%E-m? i
. ash memory write en
R [0] HIDDDDfoE { 0xD0045e }  [signed long) SREAE POTNT
R [1] H'000015fb { 0x000462 )  (signed long) Flash memory writing ...
B [2] H'0000167= { 0x000466 )  (signed long) | Flash memory write end
B[] H'00001cfh { Ox00046a )  (signed long) ONE STEP END
R [4] H'00002781 { Ox00046e ) (signed long) SUBROUTINE END
R[5 H'00003£54 { 0x000472 )  (signed long)
B orea TIANANAY o NennnaTe RPN R A -
‘ [ i -
Watchl j watch2 }\ Watchd }y Watcht [>T Buid },Debug / Findin Files } Macra }, Test }y ¥ersion Control
Ready [T E2| 3| B [Default] desktop  |Read-write  [39/60 B INS UM

The data of variable a displayed in the [Watch] window is sorted in ascending order.

Figure 6.23 [High-performance Embedded Workshop] Window (Step Out)
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6.13.3 Executing [Step Over] Command

The [Step Over] command executes a function call as a single step and stops at the next statement

of the main program.

e To step through all statements in the change function at a single step, select [Step Over] from
the [Debug] menu, or click the [Step Over] button on the toolbar.

v

Figure 6.24 [Step Over] Button

utorial — Hieh—performance Embedded Workshop — [Tutorial.c]

«% File Edit Miew Project PBuild Debug Setup Tools Test MWindow Help -0 X
Dl [ 3 & 1 8 [Debug_R8C_E8a_SvSTE x| |[SessionREC_E8a_SvSTEI x| i
O e WwE 2z WHIEw || FRADIER®DPE = ||BERHE A& a

x|
= 3 Tutorial E&;‘\ &
=-IF Tutorial :
=53 G source file Line So.. E. 5. Source |
27 [ET94 1
23 long al10]; Z‘
24 long j:
25 int i3
26 struct Sample far #p_sam;
27
28 |E180 p_sam® mallocisizeof (struct Samplell;
29 |ET1AE initlp_san);
an
= Download modules 31 |E1BS fort P10 i+ 3
Tutorialx30 - 0000 a2 |E1Co i rand{);
=l-‘3 Dependencies 3% |EICC irdi < U)g
cstartdefh 84 |EIDT iE i
3h i
inftscth 36 |EIDA alil = i3
resetpreh 37
sorth 38 |EIFD & sort (a);
typedefineh 33 EIF? chanze(a);
41 |EIFE or p_sam->s0=a[0];
4z |E208 p_sam->si=all];
43 |E218 p_sam-rs2=al];
44 |E21E p_sam-rsizalil;
45 |E229 p_sam-rsd4=a[4];
46 |E254 p_sam->s5=a[5];
47 |E25F p_sam-rsb=al6];
45 |E244 p_sam->s7=al7];
43 |E2H5 p_sam-rsi=ald];
50 |EZRD p_smp->ss=?[8]; -
al | sl < »

n e [FT =l % Tutariale |« soric

EE A E Z B H

Hame |VSluE ‘ Type ||| | |rEsET cPU ~
R a { 0xD0045e } {zigned long[10] Flash memory writing ...

R [0] H'0000794b { 0x00045e | (signed long) Flash menory write end

R [1 H'00005%9e2 0x000462 i d 1 FREAK POINT

(1] =2 { Dx } (sigme ong) Flash memory writing ...

B [z] H'000D446k { Ox000466 }  (signed long)  _| Flash menory write end

R 131 H'000041ce { 0x00046a } (signed long) ONE STEFP END

R [4] H'00003f54 { Ox00046e } {signed long) SUEROUTINE END

R [5] H'0000Z781 § Ox00047Z } [zigned long) SUERCUTINE END

Boroa Rt T T R I N T VoV L P R p—— hd e
‘ | A v

Watchl 4 Watch? j Wwatcha A wWatchd [+ Buid },Debug fi FindinFiles , Macro }, Test Jy Wersion Control

SUBROUTINE END [FT EE| EE| BBl |Default! desktop  [Read-write  41/59 3 INS HUI

Figure 6.25 [High-performance Embedded Workshop] Window (Step Over)
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6.14 Forced Breaking of Program Executions

The High-performance Embedded Workshop can force a break in the execution of a program.

Cancel all breaks.

To execute the remaining sections of the main function, select [Go] from the [Debug] menu
or the [Go] button on the toolbar.

=l

Figure 6.26 [Go] Button

The program goes into an endless loop. To force a break in execution, select [Halt] from the
[Debug] menu or the [Halt] button on the toolbar.

@

Figure 6.27 [Halt] Button
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6.15 Displaying Local Variables

The user can display local variables in a function using the [Locals] window. For example, we will
examine the local variables in the main function, which declares four local variables: a, j, i, and

p_sam.

e Select [Locals] from the [Symbol] submenu of the [View] menu. The [Locals] window is

displayed.

The [Locals] window shows the local variables in the function currently pointed to by the program
counter, along with their values. Note, however, that the [Locals] window is initially empty

because local variables are yet to be declared.

Nate Value

EXR = { 0x00045= I3
7 H'00000ff6 { Ox000486 }
i H'000a § Ox00048a }

0x00051e { Ox0OO048c }

Type

[signed lmngflﬂ]ﬁ.
[zigned long)
[zigned int)

[struct Ssmple*)

Figure 6.28 [Locals] Window

e Click mark ‘+’ at the left side of array a in the [Locals] window to display the elements.

e When the user refers to the elements of array a before and after the execution of the sort

function, it is clarified that random data is sorted in descending order.
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6.16 Break Function

The emulator has PC and hardware break functions. With the High-performance Embedded
Workshop, a PC breakpoint can be set using the [Breakpoint] sheet of the [Event] window, and a
hardware break condition can be set using the [Breakcondition] sheet.

An overview and setting of the break function are described below.

6.16.1 PC Break Function

The emulator can set up to 255 PC breakpoints. Other methods for setting a PC breakpoint than in
section 6.7, Setting a PC Breakpoint, are described below.

e Select [Eventpoints] from the [Code] submenu of the [View] menu. The [Event] window is
displayed.
o Select the [Breakpoint] sheet.

Type State Condition hotion

'\Breakpoint/(‘ Breakcondition /

Figure 6.29 [Event] Window (Before PC Breakpoint Setting)
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o Click the [Event] window with the right-hand mouse button and select [Add...] from the
popup menu.
e Enter H' 0E1FE in the [Address] edit box.

Het Break

Addrezs

Address HOODOET FE|

| ok | oAl

Figure 6.30 [Set Break] Dialog Box

e (lick the [OK] button.
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The PC breakpoint that has been set is displayed in the [Event] window.

|

| Type | Ztate | Condition | Action |
Ereakpoint Enable Address=0E1FE|Tutorial.c/41) Break

‘ Breakpuintl.'{' Breakcondition ;‘r

Figure 6.31 [Event] Window (PC Breakpoint Setting)
To stop the tutorial program at the PC breakpoint, the following procedure must be executed:

e (lose the [Event] window.

o Set the program counter value (PC = H’OE612) that was set in section 6.8, Setting Registers, in
the [Register] window. Click the [Go] button.

e If program execution is failed, reset the device and execute again the procedures above.

The program runs, and stops at the set PC breakpoint.

2 &|&
Like Sour. | E. 5. Source
an
31 |DE1B& for i=0; <103 i++ 3
22 |DE1CO i = rand();
33 [OEICC if{j <o)
34 [0E1DT I=-i;
ik 1
38 |[DE1D#A alil = i:
a7 1
a8 |[0E1FD zort(a);
29 |0E1F7 chanze(a):
40
41 |OE1FE [ 3 p_sam-rsl=all];
42 |DE208 p_zan-xs1=al1];
43 |0E213 p_sam-rs2=al2];
44 |DEZ1E p_zan-»s3=a[3];
45 |0E223 p_samn-rsd=a[4];
45 |DE234 p_zan-»sh=al[6];
47 |DE23F p_samn-rsh=al[f];
|48 OE244 posam-rs7al?l;
4

«0  Tutorialc

Figure 6.32 [Source] Window at Execution Stop (PC Break)

123
RENESAS




The [Status] window displays the following contents.

Jtatus
RAC Efa 3I¥3ITEM (Renesas Communications)
CPT BEFZ21x=x

Fun status Feady

Cause of last break BERELE FPOINT

Bun time count O000RO00min000=7 65ms

Normal

Little

Platform ,-';I Events ,-'r

Figure 6.33 Displayed Contents of the [Status] Window (PC Break)

Note: The items that can be set in this window differ depending on the product. For the settings
for each product, refer to the online help.
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6.17 Hardware Break Function

A method is given below in which the address bus condition is set under Break Condition 1 as
hardware break conditions.

o Select [Eventpoints] from the [Code] submenu of the [View] menu. The [Event] window is
displayed.

e The PC breakpoint that has been previously set is deleted. Click the [Event] window with the
right-hand mouse button and select [Delete All] from the popup menu to cancel all PC
breakpoints that have been set.

e To set a Break condition 1, click the [Break condition] tab.

o Select a line of Break condition 1 in the [Event] window. When highlighted, double-click this
line.

utorial - High-performance Embedded Workshop - [tutorial

Edit Wiew Project Build Debug Setup Tooks window Help
FHd|E| e | “ J]qﬂ o T H @ [ s 2 “Debug_HEC F8a_5Y5TE =] |[SessionRiEC_E8a_SvSTEI -] 74 4 |
@mu_ma AELIFD EE R =
]
=& Tulorl
=03 Tutorial
E| @ Assamh\y e j
s
E tion I e None Break
W R rcal condition Disab =
Diependen condition I
sectal
sarth - Addr
4| tli EBreakpaint )\Hreaktnn ¥ Don't care
Az | oifc T Addess @ Onlp program fetched addiess after
43 | ea0? Address IH'U
44 EZ1Z2
25 | =Bic Mask Mon user mask -
46 EZZ28 I _I
47 | =233 [ Data
48 | e23e ¥ Don't care _'LI
El | U k! Yalue IH‘D >
L[BT A T || weiee & Lowbyle  Highbyte £ word
ﬂ | W alue Read Ee
0 ¢ 0x000460 3 ’7 £ Read/Wiite £ Fead £ wiite ‘ nd
H'0000724kh { 0x000460
H'000059e2 { OxD00464
H'0000446b { 0000463 Ok | Cancel Apply |
H'000041c6 { Ox000%6c = =
H'0O0003£54 { 0x000470 3 {signed long)
H'00002781 { 0x000474 }  (aigned long) |
:I__;I\W'atchl Watchz f, Watch3 J, Watchd [ 4| -\ Buid jDebug ) FindinFiles p Macro j Test # ‘ersion Control
Ready Defaultl desktop  |Read-write 41759 17 s | um A

Figure 6.34 [High-performance Embedded Workshop] Window ([Break condition 1])
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e The [Break condition 1] dialog box is displayed.
e (lear the [Don't care] check box in the [Address] group box.

o Select the [Only program fetched address after] radio button and enter H' 0E1F2 as the value
in the [Address] edit box.

Break condition 1

conditian

Address

[ Dan't care

r {* Oply program fetched address after

Address |H'E1 FE

| [

[rata
=
{ i f'“
Fead M rite
') i f'“

Cancel

Figure 6.35 [condition] Page ([Break condition 1] Dialog Box)

Click the [OK] button.
The first point display in the State line changes from Disable to Enable.

The first point display in the Condition line changes from None to Address =
H’'0000E1FE (Tutorial.c/41)pcbefore.

Set the program counter value (PC = H’OE612) that was set in section 6.8, Setting Registers, in the
[Register] window. Click the [Go] button.

Note: The items that can be set in this page differ depending on the product. For the settings for
each product, refer to the online help.
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The program runs and then stops at the condition specified under Break Condition 1.

5 &|&d
Line Souwr.. | E. 5. Source
30
31 |DE1BS foarf i=0; i<10; i++ 3
32 |DEICD i = rand();
38 [oE1CE i <oy
34 (DE1DI Jo= -
35 }
36 |DE1DA alil = i;
37
3% |DET1FD sort(al;
39 [0E1F7 changela);
410
41 |0E1FE |4 | p_sam-»s0=a[0];
42 |DE20% p_zam-rsl=all];
43 |0E213 p_zam-»s2=al2];
44 |0EZ1E p_zam-rsi=al[d];
45 |0E229 p_zam-»s4=a[4];
46 |0E234 p_zam-rsh=al[f];
47 |0E23F p_zam-»sh=al[f];
|dﬁ NFEF44 o =am-*=t=alll:
4

< Tutoriale J

Figure 6.36 [Source] Window at Execution Stop (Break Condition 1)

The [Status] window displays the following contents.

Itatus
RAC Efa SYITEM (Renesas Communications)
CPU RESFZ1xxx

Fun status Ready

Cause of last break BEREAE CONDITION 1

FEun time count 0000h000min000sY82ms

Erulation mode Mormal

Endian Little

Platform r'{. Events fn'r

Figure 6.37 Displayed Contents of the [Status] Window (Break Condition 1)

Note: The items that can be set in this window differ depending on the product. For the settings
for each product, refer to the online help.
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6.18 Trace Functions
The emulator has a branch-instruction trace function.

The branch source addresses, mnemonics, operands, source lines, and labels are displayed for four
branches.

Note: The trace function uses the trace buffer housed in the device.
Devices which have no trace function cannot use this function.

6.18.1 Displaying the Trace Window
Select [Trace] from the [Code] submenu of the [View] menu.

Run the program as shown in the example of section 6.16.1, PC Break Function. The trace results
are displayed in the [Trace] window after the program execution is completed.

Z|B@E|E |w|o
PTR IP Type | Address | Instruction Source | Label
-000oo03 0003 ERANCH OOO0O0E18cC JMEP.E OE1E65H
-0aoooz  oooz BERANCH OOO0EL18C JME. B OE1R5H
-0aoo0l oool BREANCH OO00ELlGa JGE OE13EH

oooo BERANCH OOODELRE

Figure 6.38 [Trace] Window

If necessary, adjust the column widths by dragging borders in the header bar (immediately below
the title bar).

Note: The number of branch instructions that can be acquired by a trace and the trace display
differ depending on the product. For the specification of each product, refer to the online
help.
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6.19 Stack Trace Function

The emulator uses the information on the stack to display the names of functions in the sequence
of calls that led to the function to which the program counter is currently pointing.

Note: This function can be used only when the load module that has the IEEE695-type
debugging information is loaded. (However, 740 families exclude it.)

e Double-click the [S/W Breakpoints] column in the sort function and set a PC breakpoint.

g1 &4 &
Line Souwr.. | E. 5. Source

25 long t3
26 int i, §. k, zap:

28 |0EN7E gap = B3

29 |DEDET whilel zap > 0 3

30 |DED8A for{ k=0; k<gap; k++){

41 |0E047 forf izk+tzap: i<10: i=itzap I
22 |DE0AT far{j=i-gap; i»7k: j=j-zap)|
23 |0E0BE & iflalil>ali+zap] i

24 |[0E0DT t o= aljl:

45 |0EOER alil = alitzapl:

46 [0EOFF : alitzap]l = t;:

38 else
38 brealk;

41 i
42 1
4% INF123 zap = zapf?:

Figure 6.39 [Source] Window (PC Breakpoint Setting)

e Set the same program counter value (PC = H’0E612) as was set in section 6.8, Setting
Registers (again, use the [Register] window). Click the [Go] button.
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e After the break in program execution, select [Stack Trace] from the [Code] submenu of the

[View] menu to open the [Stack Trace] window.

Htack Trace X
EKind  Name Value

F sort [signed long*) { 00elhe }

F tutoriall) { 00elf? }

F main() { 00el97 }

Figure 6.40 [Stack Trace] Window

Figure 6.40 shows that the position of the program counter is currently at the selected line of the
sort () function, and that the sort () function is called from the tutorial () function.
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6.20 What Next?

This tutorial has described the major features of the emulator and the use of the High-performance
Embedded Workshop.

Sophisticated debugging can be carried out by using the emulation functions that the emulator
offers. This provides for effective investigation of hardware and software problems by accurately
isolating and identifying the conditions under which such problems arise.
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Appendix A Components of the E8a Emulator

Table A.1 lists the components of the E8a emulator.

Table A.1 Components of the Emulator (ROE0000SAKCE00)

Classi- .
fication Component Appearance Quantity Remarks
Hard-  E8a emulator 1 ROEOO008AKCEQO:
Ware  (Model: ROEODOOBAKCEQO) Depth: 65 mm,
Width: 97 mm,
Height: 21 mm,
Mass: 60.0 g
User system interface cable 1 Length: 200 mm (connector
B part not included),
Mass: 20.0 g
USB cable 1 Length: 1.5 m,
m Mass: 52.0 g
Soft- E8a emulator setup 1 ROEOO008AKCEOOSR,
ware program, @
E8a emulator self-check E8aSCP.EXE,
program,
E8a Emulator User's ROEOO008AKCEO00J,
Manual, ROEO0008AKCEOOE,
E8a Emulator Additional ROEOO008AKCEO00JPN,
Document for User’s ROEOO008AKCEOOEPN

Manual, Notes on
Connecting the xxxxx

M32C evaluation compiler
M16C evaluation compiler
740 evaluation compiler
740 evaluation assembler
and

H8 evaluation compiler

(n=1,2,8,4,..),

M3T-NC308WA
M3T-NC30WA
M3T-ICC740
M3T-SRA74

and
R0OC40008XSWO06R

(Provided with the E8a
emulator setup program)
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Appendix B Window Functions

This section describes the window functions that can be used with the High-performance
Embedded Workshop for E8a emulator. Here, the High-performance Embedded Workshop
common functions are omitted, and only the emulation functions are described.

Table B.1 Window Functions

Menu Option Shortcut Toolbar Remarks
Button
View Disassembly Ctrl+D Opens the [Disassembly]
window.
Command Line Ctrl + L Opens the [Command Line]
:
window.
Workspace Alt + K Opens the [Workspace]
o window.
Output Alt+U Opens the [Output] window.
CPU Registers Ctrl+R Opens the [Register] window.
Memory... Ctrl + M Opens the [Memory] window.
10 Ctrl + 1 Opens the [I0] window.
Status Ctrl+ U Opens the [Status] window.
Symbol Labels Shift + - Opens the [Labels] window.
Ctrl + A
Watch Ctrl + W Opens the [Watch] window.
Locals Shift + Opens the [Locals] window.
Ctrl + W
Code Eventpoints Ctrl+ E Opens the [Event] window.
i
Trace Ctrl+ T Opens the [Trace] window.
Stack Trace Ctrl + K Opens the [Stack Trace]
window.
Graphic Image... Shift + @ Opens the [Image] window.
Ctrl+ G
Waveform... Shift + Opens the [Waveform] window.
Ctrl+V
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Table B.1 Window Functions (cont)

Menu

Toolbar

Option Shortcut Button

Remarks

Setup

Radix Hexadecimal 16

Uses a hexadecimal for displaying a
radix in which the numerical values
will be displayed and entered by
default.

Decimal

Uses a decimal for displaying a
radix in which the numerical values
will be displayed and entered by
default.

Octal

Uses an octal for displaying a radix
in which the numerical values will
be displayed and entered by
default.

Binary

H

Uses a binary for displaying a radix
in which the numerical values will
be displayed and entered by
default.

Emulator ~ System...

E

Opens the [Configuration
Properties] dialog box allowing the
user to modify the debugging
platform settings.

Emulator
Setting...

Opens the [Emulator Setting] dialog
box.

Start/Stop
Function
Setting...

Opens the [Start/Stop Function
Setting] dialog box.

Debug

Debug Sessions...

Opens the [Debug Sessions] dialog
box to list, add, or remove the
debug session.

Debug Settings...

Opens the [Debug Settings] dialog
box to set the debugging conditions
or download modules.

Reset CPU =

TG
—

Resets the target hardware and
sets the PC to the reset vector
address.

Go F5

Starts executing the user program
at the current PC.

Reset Go Shift + F5

' '
— —

Resets the target microcomputer
and executes the user program
from the reset vector address.
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Debug
(cont)

Set PC To Cursor

Run..

Go To Cursor

Table B.1 Window Functions (cont)
Menu

Option

Toolbar
Shortcut Button

+

Remarks

Display PC

Starts executing the user program
at the current PC until the PC
reaches the address indicated by
the current text cursor position.

Step In

Sets the PC to the address at the
row of the text cursor.

Shift +

Step Over

Launches the [Run Program]
dialog box allowing the user to
Ctrl+Y

F11

o
ﬂ

*

enter the PC or PC breakpoint
during executing the user
program.

F10

Step Out

Displays the current PC value.

[

Step...

Executes a block of user program
before breaking.

Shift +

F11

Step

Auto
Mode

¥

Executes a block of user program

before breaking. If a subroutine
call is reached, then the

subroutine will not be entered.

Executes the user program to
reach the end of the current
function.

Assembly

Source

Launches the [Step Program]
dialog box allowing the user to

modify the settings for stepping.

Halt Program

Esc
Initialize

Connect

Steps only one source line when
the [Source] window is active.
When the [Disassembly] window
is active, stepping is executed in a
unit of assembly instructions.

Executes stepping in a unit of
assembly instructions.

Steps only one source line.

program.

Stops the execution of the user

Disconnects the debugging

platform and connects it again.

RENESAS
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Table B.1 Window Functions (cont)

Menu Option Shortcut ?ﬁltz?]r Remarks
Debug Disconnect F| Disconnects the debugging
(cont) platform. This option cannot be
used in some products.
Save Memory... Saves the specified memory area
data to a file.
Verify Memory... Verifies file contents against
memory contents.
Download Modules Downloads the object program.
Unload Modules Unloads the object program.
138
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Appendix C Command-Line Functions

The emulator supports the commands that can be used in the command-line window.

For details, refer to the online help.
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1.

Appendix D Notes on High-performance Embedded
Workshop

Note on Moving Source File Position after Creating Load Module

When the source file is moved after creating the load module, the [Open] dialog box may be
displayed to specify the source file during the debugging of the created load module. Select the
corresponding source file and click the [Open] button.

Source-Level Execution
— Source file

Do not display source files that do not correspond to the load module in the program
window. For a file having the same name as the source file that corresponds to the load
module, only its addresses are displayed in the program window. The file cannot be
operated in the program window.

— Step

Even standard C libraries are executed. To return to a higher-level function, enter Step Out.
In a for statement or a while statement, executing a single step does not move execution to
the next line. To move to the next line, execute two steps.

Operation During Accessing Files

Do not perform other operations during downloading the load module or saving in the [Verify
Memory], [Save Memory], or [Trace] window because this will not allow correct file
accessing to be performed.

Watch
— Local variables at optimization
Depending on the generated object code, local variables in a C source file that is compiled

with the optimization option enabled will not be displayed correctly. Check the generated

object code by displaying the [Disassembly] window.

If the allocation area of the specified local variable does not exist, displays as follows.
Example: The variable name is asc.

asc = ? - target error 2010 (xxxX)

— Variable name specification

When a name other than a variable name, such as a symbol name or function name, is
specified, no data is displayed.

Example: The function name is main.
main =

A variable that is allocated to register cannot be selected for monitoring.
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— Variable updating
For updating of the content of the variable that has been registered in the [Watch] window,
read the data after the break in user program execution. The realtime operation for the user
program is disabled because the user program is temporarily stopped.

5. Line Assembly
— Input radix

Regardless of the Radix setting, the default for line assembly input is decimal. Specify H’
or Ox for the H8 series microcomputers and xxxxh for the R8C/Tiny, 740, M32C and
M16C series microcomputers as the radix for a hexadecimal input.

6. Command Line Interface
— Batch file

To display the message “Not currently available” while executing a batch file, enter the
sleep command. Adjust the sleep time length which differs according to the operating
environment.

Example: To display “Not currently available” during memory_fill
execution:

sleep d’3000
memory_fill O ffff 0

— File specification by commands

The current directory may be altered by file specifications in commands. It is
recommended to use absolute paths to specify the files in a command file so that the
current directory alteration is not affected.

Example: FILE_LOAD C:\Hew3\Tools\Renesas\DebugComp\Platform\E8a\
E8aR8C\TutorialR8C\Tutorial\Debug_R8C_E8a_SYSTEM\Tutorial.x30

7. Memory Save During User Program Execution
Do not execute memory save or verifying during user program execution.

8. Load of Motorola S-type Files

This High-performance Embedded Workshop does not support Motorola S-type files with only
the CR code (H'OD) at the end of each record. Load Motorola S-type files with the CR and LF
codes (H'ODOA) at the end of each record.

9. [I/O] Window
— Display and modification
Do not change values in the [I/O] window because the emulator uses the address break
controller.
— Note that the E8a emulator does not support the display of the invalid module in the [I/O]
window. For the H8/Tiny and H8/Super Low Power series, the E8a emulator dose not
support the display of the bit information in the [I/O] window.
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10.

Note on [Register] Window Operation During Program Execution

The register value cannot be changed in the [Register] window during program execution.
Even if the changed value is displayed, the register contents are not changed actually.

11 Using Register Contents

12.

13.

14.

15.

16.

Use the value contained in a CPU register by specifying the register name prefixed by the “#”
character, e.g.: #R1, #PC, #R6L, or #£ER3 when you are entering a value elsewhere in the
High-performance Embedded Workshop, for example when displaying a specified address in
the [Disassembly] or [Memory] window.

In the R8C/Tiny, specify and enter the bank number before a register name; e.g., #0R0 or
#OROH.

Break Functions

— When the PC breakpoint is set in the flash memory area, the program is written to the flash
memory each time the user program is executed. At this time, note that the number of
rewritable times will be decreased.

— BREAKPOINT cancellation

When the contents of the BREAKPOINT address are modified during user program
execution, the following message is displayed when the user program stops.

BREAKPOINT IS DELETED A=xxXXXXXXX

If the above message is displayed, cancel all BREAKPOINT settings with the [Delete All]
or [Disable] button in the [Breakpoints] window.

Number of BREAKPOINT and [Stop At] Settings in the [Run...] Menu

The maximum number of BREAKPOINTS and [Stop At] settings allowed in the [Run...] menu
is 255. Therefore, when 255 BREAKPOINTS are set, specification by [Stop At] in the [Run...]
menu becomes invalid. Use the BREAKPOINTS and [Stop At] in the [Run...] menu with 255
or less total settings.

Note on RUN-TIME Display

The execution time of the user program displayed in the [Status] window is not a correct value
since the timer in the host computer has been used.

Note on Displaying Timeout error

If Timeout error is displayed, the emulator cannot communicate with the target
microcomputer. Turn off the emulator and the user system and connect the emulator again by
using the High-performance Embedded Workshop.

Support of Double Float Format

In the following memory operations, the double float format is not supported:

— [Fill Memory] dialog box
— [Search Memory] dialog box
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— MEMORY_FILL command

The [Format] specification in the [Copy Memory] dialog box is ignored. Memory is copied
in a byte unit.

17. Note on Using the [Run Program] Dialog Box
When [Run...] is selected from the [Debug] menu to specify the stop address, there is the
following note:
— When the breakpoint that has been set as Disable is specified as the stop address, note that
the breakpoint becomes Enable when the user program stops.

18 [Stack Trace] window
When using the NC30WA or NC8C, if parameters and local variables of a function are
referred in the call stack window and one or more parameters are on a register, the register
parameters may be interchanged with the local variables. However, the correct values are
displayed.
For NC308WA, NC30WA, or NCS8C, specify the compiler option ‘-genter’, which is used to
output the ENTER or EXITD instruction, to all functions. If this option is not specified, the
[Stack Trace] window will not be correctly displayed.

19. Memory Access during User Program Execution

When a memory is accessed from the memory window, etc. during user program execution,
the user program is resumed after it has stopped in the E8a emulator to access the memory.
Therefore, realtime emulation cannot be performed

20 Internal Flash Memory

The emulator is also available as the programming tool for mass production.

However, the actual MCU, which has been used by connecting to the emulator, has been
programmed to the flash memory at emulation and stressed. Do not use the MCU that has been
used for debugging for the mass products.

21 Suspend during Emulator Use

The host computer cannot enter suspend mode while the emulator is in use.

22 Verification of Memory

Use the FILE_VERIFY command to verify memory. Do not use [Verify Memory...] in the
[Debug] menu.

23 Overwrite of a File

In command line interface, a file that has the same name as the output file is overwritten
without asking the user.
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24 Usage with Other Products
To install the SuperH™ RISC engine C/C++ compiler package or H8, H8/300 series C/C++
compiler package after installing the emulator debugger for High-performance Embedded
Workshop, select [High-performance Embedded Workshop] as the component to be installed
in [Select Components] during installation of the compiler package.

25 Download of Load Modules

When load modules are downloaded, select [Debug] -> [Download] -> [All Download
modules].

26 [Program Flash] Mode
When microcomputers are continuously programmed, be sure to turn the target on or off.

27 Memory Access in the [Program Flash] Mode

Memory cannot be accessed in the [Program Flash] mode. In this mode, values displayed in
the [Memory] or [IO] window are dummy.

28 Memory Access during Flash Memory Programming
During flash memory programming (e.g., user program execution), operation for memory
accessing such as opening the [Memory] window is not allowed. Values displayed here are
dummy. Access the memory again after flash memory programming has been completed.
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Appendix E E8aSCP (E8a Self-Check Program)

This appendix describes the troubleshooting procedure that applies the self-check program for the
E8a emulator (E8aSCP).

E.l.  System Setup to Executethe E8aSCP

(1) The following equipment is required to execute the check program. Do not connect the user
system interface cable or the user system while the check program is running.

e E8aemulator main unit

e USB cableincluded with the E8a emulator

e User system interface cable included with the E8a emulator

e CD included with the E8a emulator

e Host computer
Install the High-performance Embedded Workshop and the USB driver on the host
computer in advance.

(2) Open the cover of the self-check connector for the emulator. Connect the user system interface
cable to the user-system connector and the self-check connector.

A\ WARNING

Fully insert the user system interface cable in the self-check
connector as shown in figure E.2.
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Figure E.1 Connecting the User System Interface Cable when Using the E8aSCP
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Figure E.2 Connecting the User System Interface Cable to the Self-Check Connector

(3) Start up the host computer, and connect the E8a emulator to the USB connector of the host
computer viathe USB cable provided.
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E.2.  Executing the Self-Check Program

(1) Execute [Program]-[ Renesas]-[ High-performance Embedded Workshop]-[E8a Self Check
Program].

E8a Self Gheck Proeram YW1 _00.001

EBa Self Check Program

STATUS
START QUIT

NO.

Figure E.3 Starting Up the E8aSCP
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(2) Click the ‘START’ button. The following message will be displayed:
‘Please confirm that the User interface cable is connected to the self-check connector in a

correct direction’.

Confirm that the user system interface cable is connected to the self-check connector in the
correct direction, as shown in figure E.2, and click the [OK] button. The self-check program
will start.

Meszage

Pleaze confirm that the User interface cable iz connected to the zelf-check connector in a correct direction.

STATUS

Figure E.4 Confirming Connection of the User System Interface Cable
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(3) Themessage ‘TEST1isrunning.’ or ‘TESTZ2 isrunning.” will appear in the window. This
indicates the start of the self-check program.

E8a Self Gheck Proeram YW1 _00.001

TEST]I 1s running.

EBa Self Check Program

STATUS

NO. 2

Figure E.5 Running the Self-Check Program
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(4) When ‘TEST3 iswaiting.” starts, the following message will be displayed:
‘Please remove the User interface cable from the self-check connector to execute TEST3.’

When the above message is displayed, remove the user system interface cable from the self-
check connector and close the cover of this connector. Click the [OK] button. The self-check
program will be continuously executed.

. EBa Self Check Program V1.00.01

TEST3 1s wailting.

Meszage

STATUS |

NO. |

Figure E.6 ‘Please remove the User interface cable from the self-check connector to execute
TEST3.” Message
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(5) The message ‘ TEST3 isrunning.” will appear in the window. This starts execution of the self-
check program.

E8a Self Gheck Proeram YW1 _00.001

TEST3 1s running.

EBa Self Check Program

STATUS
START LOG QUIT

NO. 2

Figure E.7 Running the Self-Check Program
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(6) The message ‘PASS or ‘FAIL’ will be displayed. ‘PASS' indicates that the emulator is
working correctly. Click the [QUIT] button to exit the self-check program.

E8a Self Gheck Proeram YW1 _00.001

PASD

The Eda self-check ended normallw.

EBa Self Check Program

STATUS
START LOG QUIT

NO. 2

Figure E.8 Quitting the Self-Check Program
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If ‘FAIL’ is displayed during execution of the self-check program, the content of an error is
displayed at the center of the window. Table E.1 shows error messages.

E8a Self Gheck Proeram YW1 _00.001

FALL

The Eda haz failed.

EBa Self Check Program

STATUS 0003
START LOG QUIT

NO. 2

Figure E.9 Window Showing an Error

Clicking the [LOG] button opens the dialog box for selecting a file. Specify the destination to save
the result of program execution. The result will be saved as a text file.
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Table E.1 Error Messages

Error Message

Description

The E8a has failed.

The E8a emulator has become faulty.

If this applies to the contents guaranteed in
'IMPORTANT' described in this user's manual, we will
repair or replace your faulty product free of charge.

If this guarantee does not apply to your product's
fault, we will repair the product or replace it with a
new one with extra-charge. However, replacement
will be lower in cost and we recommend that you
purchase a new emulator.

Please connect the User interface cable
with the self-check connector in a correct
direction.

Connect the user system interface cable to the self-
check connector in the correct direction, as shown in
figure E.2, before running the self-check program.

Because the User interface cable was
connected with to self-check connector,
TESTS3 was interrupted.

Perform the self-check again from the
beginning.

Execution of TEST3 was halted because the user
system interface cable was not removed from the
self-check connector before starting ‘TEST3 is
running.’

Connect the user system interface cable to the self-
check connector in the correct direction, as shown in
figure E.2, and restart the self-check program from
the beginning.

An error occurred during USB 1/O
processing.

The USB cable was disconnected during execution of
the self-check program, or the E8a emulator became
faulty. Execute the self-check program again.

If this error message is displayed again, the emulator
could be faulty.
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